
Creating Reports Using
Db2 Web Query Designer
Volume 2 
Release 2.3



Active Technologies, EDA, EDA/SQL, FIDEL, FOCUS, Information Builders, the Information Builders logo, iWay, iWay
Software, Parlay, PC/FOCUS, RStat, Table Talk, Web390, WebFOCUS, WebFOCUS Active Technologies, and WebFOCUS
Magnify are registered trademarks, and DataMigrator and Hyperstage are trademarks of Information Builders, Inc.

Adobe, the Adobe logo, Acrobat, Adobe Reader, Flash, Adobe Flash Builder, Flex, and PostScript are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.

Due to the nature of this material, this document refers to numerous hardware and software products by their
trademarks. In most, if not all cases, these designations are claimed as trademarks or registered trademarks by their
respective companies. It is not this publisher's intent to use any of these names generically. The reader is therefore
cautioned to investigate all claimed trademark rights before using any of these names other than to refer to the product
described.

Copyright © 20 , by Information Builders, Inc. and iWay Software. All rights reserved. Patent Pending. This manual, or
parts thereof, may not be reproduced in any form without the written permission of Information Builders, Inc.



Contents

1. Creating Reports . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5

Styling Reports in Db2 Web Query Designer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5

Setting General and Columnar Report Properties. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8

Applying Themes to Reports. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8

Formatting Text in a Report. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9

Formatting Cells in a Report. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .10

Controlling Column Width. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

Adding Margins to Report Headings and Footings. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .13

Formatting Across Column Labels in a Report. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

Styling Column and Row Totals in a Report. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

Adding Headers and Footers to Content . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

Adding Filters to a Visualization . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .20

Adding Static Filters to Content. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22

Adding Prompted Filters to a Visualization. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30

Filtering a Chart with Visual Selections. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .36

Chaining Filter Control Selections. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39

Applying Prompted Filters From External Content. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41

Summarizing Numeric Data Using Filters. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46

Working With Required Parameters. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52

Working With Single and Multiple Select Lists. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .53

Working With Slider Controls on a Page. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57

Working With Date Controls. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 62

Styling Filter Controls in a Visualization. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63

Choosing an Event Model for Your Page Filter. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71

Using Global Name to Synchronize Filter Controls . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74

Bookmarking Control Selections in a Page. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .76

Setting Dynamic Default Values for Filter Controls. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 78

Changing a Field Format . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 85

Creating Calculations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 94

Performing Basic Calculations. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 95

Using Prefix Operator Aggregation Functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 107

Using Quick Transforms to Apply Analytical Functions to Data Fields . . . . . . . . . . . . . . . . . . . . . . . 110

Using Db2 Web Query  3



Using Dynamic Grouping for Dimension Field Values . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .122

Creating Numeric Ranges With Binning . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 125

Editing an Existing Bin. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .129

Contents

4 Information Builders



Chapter1
Creating Reports

You can create reports in a visualization in Db2 Web Query Designer similar to the way in
which you create charts. Reports allow you to communicate information at a high level of
detail using a familiar tabular format. You can create a stand-alone report in a
visualization, or combine multiple reports in a page.

In this chapter:

Styling Reports in Db2 Web Query Designer

Adding Headers and Footers to Content

Adding Filters to a Visualization

Changing a Field Format

Creating Calculations

Using Prefix Operator Aggregation Functions

Using Quick Transforms to Apply Analytical Functions to Data Fields

Using Dynamic Grouping for Dimension Field Values

Creating Numeric Ranges With Binning

Styling Reports in Db2 Web Query Designer

You can apply styling changes to a report to help it visually match the styling of your other
content, and make it easier to read and more visually appealing. You can style a report from
the Format tab on the Properties panel.

On the Format tab, you can select a theme (.sty file, or StyleSheet), to apply to your report.
Themes style multiple components of a report, such as headers, column titles, and data text,
all at once. Themes include associated cascading style sheet files along with a StyleSheet to
help coordinate styling between an individual report and the entire visualization.
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When creating a stand-alone report, the default theme is Designer 2018. When you change a
visualization into a page by adding a second new content item, the theme used for the report
is applied to the page. When you add items to the page, either by creating them or adding
them as external content, the page theme is used as the default for all content items. You
then can change the theme for each individual item.

If you prefer, you can specify one of the themes included with Db2 Web Query, such as the
Designer 2018, Light, Midnight, or Vivid theme, select a custom theme saved to the Global
Resources area in the repository, or you can click Custom to select a legacy template or a
StyleSheet saved to a workspace in your repository. When you select a StyleSheet using the
Custom option, it is applied to the report and added to the Theme list.

To make a custom theme available directly from the Theme menu, create a folder for it in the
Global Resources area, in the Themes folder, in the Custom folder. In that folder, you can add
a custom StyleSheet to use with charts and reports, and a custom CSS file to use for pages.
The .sty file and .css file must both be named theme. An .sty file and .css file that share the
same theme folder are associated. If you select a theme for a report, which uses the .sty file,
then when you convert it to a page, the associated .css file is used as the page theme, by
default.

Tip: When creating a custom theme, you can copy the CSS and StyleSheet syntax from existing
themes to use as a model.

Note: Charts and reports created for use on pages can use a transparent background to allow
the defined background color of the page containers to show through. Since the themes used
for charts and reports (.sty files) can be associated with themes for pages (.css files), you can
coordinate the background, text, and element colors used in both themes to create content
with unified styling. At design time, the page theme associated with the chart or report theme
is used for the canvas background. This is for visibility purposes only, and shows how the chart
or report will appear when added to a page with the associated theme. The stand-alone chart
or report does not include this background.

If a chart or report is run stand-alone instead of being added to a page, the run-time view
displays a white background only. This means that if, in order to display on a dark colored
page, the font color in the selected theme is defined as white and uses a transparent chart
background, then the text will not be visible on the white preview background. An example of
such a theme is the Midnight theme, provided as one of the default themes in the Global
Resources. To view the white text, build your chart or report on the canvas, or add it to a page
container with a dark background.

You can apply styling changes to a report to help it visually match the styling of your other
content, and make it easier to read and more visually appealing. You can style a report from
the Format tab on the Properties panel.

Styling Reports in Db2 Web Query Designer
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On the Format tab, you can use the quick access menu to select the section or component of
the report whose styling properties you want to change, as shown in the following image.

You can style the following sections or components of a report:

General. Set properties, such as a theme, font, or background color, that affect the entire
report.

Headings. Set text, border, background, and cell margin properties for report level and page
level headings.

Columns. Format the text and cells for column titles and data values.

Across Columns. Format the text and cells for across column titles and data values. You
can create across columns by adding dimensions to the Columns bucket in a report.

Row Totals. Set text and cell properties for column and row totals.

Footings. Set text, border, background, and cell margin properties for report level and page
level footings.

If you are styling Columns, Across Columns, or Row Totals in a report, you can select a specific
field whose title or values you want to style. You can revert the changes you made in any area
by clicking Reset to Theme on the Format tab. Only the settings in the selected area are reset.

1. Creating Reports
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Setting General and Columnar Report Properties

When you select General from the quick access menu on the Format tab, you are presented
with options to style and format the entire report. These options include the ability to set a
theme, change the output format, change the font style and size, style cells and cell borders,
set cell margins, and configure how column widths are set. Font and cell styling options can be
set for the entire report, or for specific columns within it.

Applying Themes to Reports

On the Format tab, in the General settings, in the General Options section, you can select a
theme (.sty file, or StyleSheet), to apply to your report from the Theme menu. Themes style
multiple components of a report, such as headers, column titles, and data text, all at once.
Themes include associated cascading style sheet files along with a StyleSheet to help
coordinate styling between an individual report and the entire visualization.

When creating a stand-alone report, the default theme is Designer 2018. When you change a
visualization into a page by adding a second new content item, the theme used for the report
is applied to the page. When you add items to the page, either by creating them or adding
them as external content, the page theme is used as the default for all content items. You
then can change the theme for each individual item.

If you prefer, you can specify one of the themes included with Db2 Web Query, such as the
Designer 2018, Light, Midnight, or Vivid theme, select a custom theme saved to the Global
Resources area in the repository, or you can click Custom to select a legacy template or a
StyleSheet saved to a workspace in your repository. When you select a StyleSheet using the
Custom option, it is applied to the report and added to the Theme list.

To make a custom theme available directly from the Theme menu, create a folder for it in the
Global Resources area, in the Themes folder, in the Custom folder. In that folder, you can add
a custom StyleSheet to use with charts and reports, and a custom CSS file to use for pages.
The .sty file and .css file must both be named theme. An .sty file and .css file that share the
same theme folder are associated. If you select a theme for a report, which uses the .sty file,
then when you convert it to a page, the associated .css file is used as the page theme by
default.

Tip: When creating a custom theme, you can copy the CSS and StyleSheet syntax from existing
themes to use as a model.

Styling Reports in Db2 Web Query Designer

8  Information Builders



Note: Charts and reports created for use on pages can use a transparent background to allow
the defined background color of the page containers to show through. Since the themes used
for charts and reports (.sty files) can be associated with themes for pages (.css files), you can
coordinate the background, text, and element colors used in both themes to create content
with unified styling. At design time, the page theme associated with the chart or report theme
is used for the canvas background. This is for visibility purposes only, and shows how the chart
or report will appear when added to a page with the associated theme. The stand-alone chart
or report does not include this background.

If a chart or report is run stand-alone instead of being added to a page, the run-time view
displays a white background only. This means that if, in order to display on a dark colored
page, the font color in the selected theme is defined as white and uses a transparent chart
background, then the text will not be visible on the white preview background. An example of
such a theme is the Midnight theme, provided as one of the default themes in the Global
Resources. To view the white text, build your chart or report on the canvas, or add it to a page
container with a dark background.

Formatting Text in a Report

You can use text formatting options to change the font, font style, alignment, size, and color of
the text in your report. On the Format tab, in the General options, you can set these options for
the entire report.

To set the same properties but only apply them to particular columns in your report, select
Column from the quick access menu. In the Select Elements and Columns area, you can then
specify whether your formatting should apply to the column titles, data values, or both, and
which column should be affected. This allows you to set styling options that affect specific
columns of the report, highlighting or distinguishing certain fields.

The text formatting options are shown in the following image.

1. Creating Reports
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A list of default fonts is provided. To add a font to this list, specify the font files for each font
style, such as regular, bold, and italic, in the fontuser.xml file, in your server installation. This
file is located in the etc subdirectory of the server configuration directory, for example, /qibm/
UserData/qwebqry/ibi/srv/wfs/etc. If you are configuring a TrueType font, you do not need to
specify the AFM font metrics file.

Formatting Cells in a Report

You can style the body of your report by applying cell border lines, specifying cell background
colors, and setting cell margins. These options can help to make your report more legible by
separating and spacing out the text, and by delineating different rows of data. On the Format
tab, select General from the quick access menu to apply this formatting to the entire report.
Select Columns and then make selections from the Select Elements and Column menus to
apply cell formatting to the data values, column headers, or both areas of the selected column
or columns.

You can add borders to the report to visually separate each value in the report. Borders are
applied around each cell. Select the Show Border check box to enable cell borders. You can
then set the border style, thickness, and color. The following border styles are available:

Solid. Applies a solid line border.

Dot. Applies a dotted line border.

Dash. Applies a dashed line border.

Double. Applies a two line border.

Groove. Applies a three-dimensional grooved border. Half of the border is shaded to make
it appear three-dimensional.

Ridge. Applies a three-dimensional ridged border. The shaded half of the ridged border is
opposite to that of the grooved border.

Inset. Applies a three-dimensional inset border. The inset border is shaded similarly to the
ridged border.

Outset. Applies a three-dimensional outset border. The outset border is shaded similarly to
the grooved border.

Note that since these border options are applied around the entire cell, they are considered
more general than side-specific borders that can be set in a theme or StyleSheet. If your
theme or StyleSheet uses these side-specific borders, they will override the borders applied in
Db2 Web Query Designer.

Styling Reports in Db2 Web Query Designer
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You can change the background color that appears behind the entire report, only the column
titles, or only the data values in one or more columns of a report. Click the color swatch next
to Report, Title Row, or Data Row to change the background color for the associated area. If
you change the color for Report, the background color of the entire report, including the column
title area and data values, is changed. Alternatively, you can set the background color for just
the column titles using just the Title Row color option, or for just the data values using the
Data Row color option. If you select Columns from the quick access menu and then select a
specific column from the Select Elements and Columns menus, the background color is only
applied to a single column.

When setting the background color for the data values in the report, you can apply different
colored bands to made it easier to differentiate different rows or sort groups. You can set
alternating bands in a repeating pattern of up to 4 rows. To add bands, click the plus (+) icon
to the right of the Data Row option, then set a second color. To add another color to the band
pattern, click the plus (+) sign again. To remove a band color, click the minus (-) sign. The
following image shows a report with 4 Data Row colors set in a pattern of yellow, white, blue,
and white.

1. Creating Reports

Using Db2 Web Query  11



By default, each band spans a single row of the report. As an alternative, you can set each
band to span a sort group, visually distinguishing values for different sort fields. To change the
scope of each band, open the Alternate On menu and select a sort field in your report. To
following image shows a report with 4 Data Row colors set in a pattern of yellow, white, blue,
and white, alternating on each value of the Sale Quarter field.

Styling Reports in Db2 Web Query Designer
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To better space out the values in your report, you can change the cell margins. You can select
preset small, medium, and large margin options, or click the ellipsis button to set custom cell
margins. When setting custom margins, you can set different margin sizes for each side of the
cells in your report. When setting custom margins, note that the selected units are used. The
default unit is inches.

To undo all custom styling changes made in the General options or Columns options, click
Reset to Theme. All options revert to their default values, which are dependent on the theme
used in the report.

Controlling Column Width

When you create a report, the width of each column depends upon the values in the column,
and the width of the page in which the report is displayed. Three options are available to set
column width behavior. They are available in the Column Width menu, in the Other Options
section of the General options on the Format tab.

The default Column Width option is autofit. When the autofit option is used, the width of each
column is set to fit the column title or row with the most characters, minimizing the amount of
space that each column uses while still displaying each value in its entirety.

If you change the Column Width option to based on value, the maximum width of each column
is based on the format of each field used in the report. If the report is filtered so that the
longest values are not included, the column width is still wide enough to include those values.

Select fixed value to create a report that always fills the width of the container into which it is
placed, no matter how wide the container is.

Note that if your theme specifies values for the SQUEEZE or AUTOFIT options, that this may
override the Column Width setting in Db2 Web Query Designer.

Adding Margins to Report Headings and Footings

When you edit the text in the heading or footing of a chart or report, a set of basic text styling
options appears in the styling toolbar at the top of the canvas. This toolbar provides options to
change the font, text size, font style, alignment, text color, and background color of the
heading or footing text. For more information about these options, see Adding Headers and
Footers to Content on page 16.

1. Creating Reports
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You can set margins for the headings and footings in a report from the Format tab. Open the
Format tab and then select Headings or Footings from the quick access menu. In the Heading
Options and Footing Options areas, you can apply a preset margin by selecting the preset
Small, Medium, or Large options, or you can select the custom margin option and use a
spinner control to set your own top and bottom margins separately. These can be set in
intervals of 0.05 inches.

Formatting Across Column Labels in a Report

When you add a field to the Columns bucket in a report, measure columns are repeated for
each value in that field. The field values are shown above the measure column titles,
identifying the across field value that they represent.

When creating a report with across fields, such as a crosstab report, you can select Across
Columns from the quick access menu on the Format tab to style the field names and values for
each one. As when styling columns in a report, from the Select Elements and Columns menus,
you can choose whether to style the field titles and values, or just one or the other. You can
also choose whether to style the field titles and values for all across fields, or a single across
field. Note that while the default field selection is All Columns, across field names and values
display in a row. All Columns in this case refers to all columns from your data source, and
allows you to style across field titles and values for all fields in the Columns bucket.

You can style across field titles and values by changing the font, style, alignment, size, and
color of the text; changing the background color of the title and values; and adjusting margins.

Styling Reports in Db2 Web Query Designer
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In the Other Options area, you can select Show title on the side to display the across field titles
and value in the same row of text. This is especially useful in Excel output, where placing the
across field title on a separate row from the values would result in empty cells. Select Hide
null columns to hide across values that only have null values on a page of a report, so that
columns without values are not shown. For example, the following image shows a report with
the Hide null columns option enabled and page breaks on the Customer Business Sub Region
field. Since there are no values in the SA-Span subregion for the Sale Year value of 2015, the
columns for that year are removed. Since there were sales in 2015 in the SA-Port region, the
columns are still included on that page of the report.

You can also select Repeat across values to show the across value above every measure
column in the report instead of only once for each group of measure columns.

Styling Column and Row Totals in a Report

As with the data values in a report, you can apply styling to the row and column totals in a
report to visually separate them from the rest of the values in your report and to draw attention
to them. To add row and column totals to a report, on the Settings tab, in the Content Settings
area, select Enable column totals and Enable row totals. To style your totals, on the Format tab,
select Row Totals or Column Totals to display row or column total styling options. These
options include text styling options, such as the font, style, alignment, size, and color;
background color options; and cell margin sizing.

From the Select Elements and Columns menus, you can choose whether the styling changes
should affect the total label, values, or both. When styling row totals, you can also choose
which columns are affected if there are across columns in the report. When row totals are
added to a report with across columns, a separate row total column is generated for each
measure field in the report. When there are no across fields, all measure fields are summed
into a single row total column to which your styling is applied.

1. Creating Reports
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Column totals, on the other hand, are always arranged into a single row to which you can apply
styling. However, if you select a single column from the drop-down menu, then you can style
the total value, or values if there are across columns, for the selected field. The styling that
you apply to the column totals is also applied to subtotals and recomputes, by default.

Adding Headers and Footers to Content

You can use headers and footers to add key information, such as the purpose of your chart or
report and the audience for whom it is intended.

You can add multiple lines of information into the heading and footing areas, and apply
different styling options to different sections of the heading or footing. This accommodates
thorough explanations and additional information, while offering the most readable
presentation.

When you create a chart or report, the heading area is available above your content, and the
report footer is available below your content. You can click within these areas to edit them. To
show or hide these areas, on the Settings tab, expand the Content section, then select the
Enable heading or Enable footing check boxes.

When you double-click the Page Heading or Page Footing placeholder text in the canvas, the
heading or footing is selected for editing and the styling toolbar appears.

Adding Headers and Footers to Content
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You can make styling changes to the text in your headers and footers, according to your
preferences. Using a WYSIWYG canvas, formatting changes are applied instantly, allowing you
to see the results of your styling selections as you make them. When editing your header or
footer, you can find the options at the top of the canvas, as shown in the following image.

You can change the font and font size using the drop-down lists. You can add bold, italic, and
underline accents to your text. In addition, you can change the positioning of your text (left,
center, and right). You can also customize the color of the text, as well as the background of
the header or footer text area. When your formatting is complete, you can close the toolbar
and continue working with your report. The canvas adjusts to ensure that all lines of the
heading or footing are visible.

You can add a new line in the heading and footing by pressing the Enter key. The number of
lines of heading and footing you can add to a report is only limited by the available space on
your screen. A scrollbar is added to a report if all of the data cannot fit on the canvas or in the
container.

1. Creating Reports
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When you are done editing the heading or footing, click the X button on the styling toolbar to
close it. Once you have edited the header or footer, the updated text will appear when the
report is run.

If you delete the header or footer text and then close the styling toolbar, the header or footer is
removed from the report. You can select the header or footer area and enter text to add them
to the report again.

Heading and footing text in Db2 Web Query Designer is created at the page level, so the
heading or footing is displayed for each separate page of a chart or report. You can create
separate pages in a chart by adding a field to the Multipage bucket, or in a report by right-
clicking a field in the Rows bucket, pointing to Insert breaks, and selecting Continuous
numbering or Restart at 1.

You can add dynamic heading or footing text by dragging a field from the Fields tab into the
heading or footing text area, or by typing a less-than sign (<) followed by the field name. At run
time, the first value for the selected field is displayed in place of the field name in the header
or footer. You can combine dynamic page heading or page footing text with filters or page
breaks to provide more relevant information at run time.

Procedure: How to Add a Dynamic Page Heading to a Report

You can add a dynamic page heading to a report that changes depending on filter selections
and sort values for each page.

1. Open Db2 Web Query Designer. On the default Db2 Web Query Home Page, click Visualize
Data.

Db2 Web Query Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

Once you select a data source, Db2 Web Query Designer loads with options to create a
single content item.

3. On the Content picker, select a report format, such as the standard report or grid report
layout.

4. With the Fields tab selected on the sidebar, In the Dimensions area of the Resources
panel, expand Product, and add the Product Category and Product Subcategory fields to the
Rows bucket, in that order.

5. In the Measures area of the Resources panel, expand Sales, and drag Quantity Sold and
Revenue to the Summary bucket.

6. Create a filter for Customer Country.

In the Dimensions pane, expand Customer and drag Customer Country into the Filter
toolbar.
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7. Select Argentina, and click outside of the filter control to apply the filter.

8. Create a page break after each Product Category value.

Right-click the Product Category field in the Rows bucket, point to Insert Breaks, and click
Continuous numbering.

9. Double-click the Page Heading text above the report to select it for editing.

10. Delete the placeholder text in the heading area, and type Sales for.

11. From the Dimensions pane, drag the Product Category field into the heading area after
where you typed Sales for.

The heading should resemble the following image. Dynamic values for the Product
Category field will be substituted for the text string starting with the less-than sign (<) at
run time.

12. Click the close button on the styling toolbar to finish editing.

13. On the Properties panel, on the Settings tab, expand the Settings area and select Enable
footing.
The page footing placeholder text appears at the bottom of the page.

14. Double-click the page footing area to select it for editing.

15. Type, This report shows figures for sales in.

16. From the Dimensions pane, drag the Customer Country field into the footing area after the
text that you just typed.

The name of the field, with a less-than sign in front of it, appears in the page footing area.

17. With the entire page footing text selected, click the Italic button on the styling toolbar.

18. Click Run in new window to see a run-time view of the report.

Notice that the page header appears and displays a different value for each Product
Category value. The Page footer appears below each section of the report, and indicates
that values are for Argentina, since this was the value selected for the Customer Country
filter. If you were to select a different value for Customer Country, the footing text would
automatically change.
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The following image shows an example of what a section of the report may look like.

Adding Filters to a Visualization

As you create charts and styled tabular content in Db2 Web Query Designer, you may want to
narrow the display of information that is shown. You can do this by creating filters for fields in
your data source. You can also use filters as a way to create custom displays of the data that
you show in your content. For example, you may only want to show revenue information for
specific product categories and models in a given year, or for product categories that exceed a
certain revenue value.

Adding Filters to a Visualization

20  Information Builders



Filters in Db2 Web Query Designer can utilize one of two behaviors: static and prompted
filtering. Static filters are applied to individual content items at design time, and allow you to
apply consistent filter values to a chart or report. Prompted filters, on the other hand, allow
users to select the filter values to use in your content at run time. When you create a new
prompted filter, it affects all new content on the page. In addition to adding prompted filters to
new content, when existing content using a prompted filter is added to a page, you can create
automatic filter controls that can be used at run time. Any content that uses the same
parameters can be filtered using the same control. These controls are not generated for static
filters.

To create a static filter for a selected field, drag it from the Fields tree on the Resources panel
to the Filter bucket, which is located below the field container buckets on the Properties panel
when you select a content item. When you create a static filter, the Add Filter dialog box
appears, as shown in the following image.

You can select filter values and the relationships those values have to the data that you want
to display in your chart or report. Static filters can only be created for new content.
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You can add prompted filters to a visualization using new or existing content in one of the
following ways:

When creating new content, drag a data field to the Filter toolbar below the page toolbar.

When creating new content, right-click a data field and click Add to filter toolbar.

When creating or interacting with new content, select one or more sections of a chart by
clicking or lassoing them, then click Keep.

When creating or interacting with new content, use the filter options in the In-Document
Analytics menu on the column of a report.

When creating a visualization from existing content, add an item that uses dynamic
parameter filters to the visualization.

Click the resulting label on the Filter toolbar to open a control, from which you can select
default filter values. Users will be able to change the selected value at run-time.

Adding Static Filters to Content

Filters allow you to limit the data that displays in your content, making it easier to find useful
information by removing extraneous data values. You can create prompted filters, which allow
users to select the filter values to use in your content at run time, or you can create static
filters, which are always applied to your content whenever it is run. Prompted filters allow you
to create controls when the content that uses them is added to an assembled page, while
static filters do not. Additionally, prompted filters affect all new content on the page, or any
referenced content that uses the filter. Static filters, on the other hand, affect only the item for
which the filter was created.

Static filters are a good choice when you want the same filter values to be applied to your
content at all times, or want to create a filter that only affects a single content item.

To create a static filter, when creating a new chart or report, drag a field into the Filters bucket
on the on the Settings tab of the Properties panel. The Add Filter dialog box opens, and
presents options relevant to the type of field that you are filtering.

These options also differ depending on whether you are filtering compared to selected values
or to another field. You can change this option by setting the Compare to option to Value or
Field.
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When you set the Compare to option to Value you can filter alphanumeric fields using the
following options:

Select values. When using the Value comparison type, select the values that will be used
to define the filter.

Select from data. Search for and select values from the data source used in your
content.

Click Load values from data to display all available values from the selected field in the
left list. Select one or more values and click Add to add them to the list of selected filter
values on the right. To remove a value from the list of selected filter values, select one
or more values and click Remove. You can also click Clear List to remove all selected
values.

Select from file. Allows you to pull data values from a file on your system. You can
select a delimited flat file, such as a CSV file, or an Excel spreadsheet from which to
import values for selection. These values are taken from the first column of the file.
This option can be an easy way to select a large number of values that are found in
another data source.

Click Load values from file to select a data file and display all available values from it in
the left list. Select one or more values and click Add to move them to the list of
selected filter values on the right. To remove values from the list of selected filter
values, select one or more values and click Remove, or click Clear List to remove all
values.

Enter manually. Type a value and click Add or press the Enter key to move it to the list
of selected filter values on the right. Multiple values must be typed separately. You can
also choose whether or not to include missing or blank values in the filter. To remove a
value from the list of selected filter values, select one or more values and click Remove,
or click Clear List to remove all selected values.

Wildcard. Manually type a single string that you can use to select multiple filter values.
You can specify that the values in your content should start with the string, end with the
string, or contain the string at any point. Wildcard value filtering is case-sensitive. You
cannot use a wildcard filter value at the same time as specified values.

Exclude. Available when using the Value comparison type. When the Exclude check box is
selected, the values selected for the filter are excluded from the request. When cleared,
which is the default state, the selected values are included.
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The Add Filter dialog box when filtering an alphanumeric field is shown in the following image.

When you set the Compare to option to Value, you can filter numeric fields using the following
options:

Select values. Select the values or field that will be used to define the filter.

Select ranges. Provides options to specify a range of values for your filter. When
selecting data ranges, you can apply an aggregation option to use when filtering the
selected field. Use None to filter on data values before aggregation, or use a different
aggregation to filter on sorted values, aggregated by the selected operation. For
example, use Summary to filter by measure values summed for each sort value. For
more information, see Summarizing Numeric Data Using Filters on page 46.

Single value. Select a filter operator, then filter for all values before or after a
selected start or end point. You can select a value using the slider or type a value
into the text box.
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Range of values. Set a static range of values to use for the filter. Select a start and
end point using the slider or text boxes, and set filter operators for each.

You can type a value that is outside the range of values in your data. In this case, the
text box displaying the value is outlined in purple and a message indicates that the
value is out of range.

Select from data. Search for and select values from the data source containing the
filter field.

Click Load values from data to display all available values from the selected field in the
left list. Select one or more values and click Add to add them to the list of selected filter
values on the right. To remove a value from the list of selected filter values, select one
or more values and click Remove. You can also click Clear List to remove all selected
values.

Select from file. Allows you to pull data values from a file on your system. You can
select a delimited flat file, such as a CSV file, or an Excel spreadsheet from which to
import values for selection. These values are taken from the first column of the file.
This option can be an easy way to select a large number of values that are found in
another data source.

Click Load values from file to select a data file and display all available values from it in
the left list. Select one or more values and click Add to move them to the list of
selected filter values on the right. To remove values from the list of selected filter
values, select one or more values and click Remove, or click Clear List to remove all
values.

Enter manually. Type a value and click Add or press the Enter key to move it to the list
of selected filter values on the right. Multiple values must be typed separately. You can
also choose whether or not to include missing or blank values in the filter. To remove a
value from the list of selected filter values, select one or more values and click Remove,
or click Clear List to remove all selected values.

Exclude. Available when using the Value comparison type. When the Exclude check box is
selected, the values selected for the filter are excluded from the request. When cleared,
which is the default state, the selected values are included.

1. Creating Reports

Using Db2 Web Query  25



The Add Filter dialog box when filtering a measure field is shown in the following image.

When you set the Compare to option to Value, you can filter date fields using the following
options:

Select values. Select the values or field that will be used to define the filter.

Select ranges. Provides options to specify a range of dates for your filter.

Single date. Filter for all dates before or after a selected start date or end date, by
selecting a filter operation and a date value.

Range of dates. Set a static range of dates to use for the filter by selecting a start
and end date and setting filter operators for each.

Select from data. Search for and select values from the data source containing the
filter field.
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Click Load values from data to display all available values from the selected field in the
left list. Select one or more values and click Add to add them to the list of selected filter
values on the right. To remove a value from the list of selected filter values, select one
or more values and click Remove. You can also click Clear List to remove all selected
values.

Select from file. Allows you to pull data values from a file on your system. You can
select a delimited flat file, such as a CSV file, or an Excel spreadsheet from which to
import values for selection. These values are taken from the first column of the file.
This option can be an easy way to select a large number of values that are found in
another data source.

Click Load values from file to select a data file and display all available values from it in
the left list. Select one or more values and click Add to move them to the list of
selected filter values on the right. To remove values from the list of selected filter
values, select one or more values and click Remove, or click Clear List to remove all
values.

Enter manually. Type a value and click Add or press the Enter key to move it to the list
of selected filter values on the right. Multiple values must be typed separately. You can
also choose whether or not to include missing or blank values in the filter. To remove a
value from the list of selected filter values, select one or more values and click Remove,
or click Clear List to remove all selected values.

Exclude. Available when using the Value comparison type. When the Exclude check box is
selected, the values selected for the filter are excluded from the request. When cleared,
which is the default state, the selected values are included.
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The Add Filter dialog box when filtering a date field is shown in the following image.

Set the Compare to value to Field to filter the selected field in relation to another field in the
request. For example, you could use this filter to identify values for which the revenue was less
than the cost of goods sold. When filtering by compared field values, the following options are
available:

Source aggregation. Available only for numeric fields. Select an aggregation option to use
for filtering the selected field. Use None to filter on data values before aggregation, or use
a different aggregation to filter on sorted values, aggregated by the selected operation. For
example, use Summary to filter by measure values summed for each sort value.

Operator. Set the relationship that will define how the filter is applied. Options are:

Equal to. Values display in your content if they match the specified filter values.

Not equal to. Values display in your content if they do not match the filter values.

Greater than or equal to. Values display in your content if they match the selected
filter values, come after them alphabetically, or have a higher numeric value.
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Greater than. Values display in your content if they come after the selected filter
value alphabetically or have a higher numeric value.

Less than or equal to. Values display in your content if they match the selected filter
value, come before it alphabetically, or have a lower numeric value.

Less than. Values display in your content if they come before the selected filter
value alphabetically or have a lower numeric value.

Compare aggregation. Select an aggregation to apply to the field that the selected field
is being compared to. Use None to compare to data values before aggregation, or use a
different aggregation to compare to sorted values, aggregated by the selected
operation. For example, use Summary to compare values from the selected field to
values in the comparison field summed for each sort value.

Compare field. When using the Field comparison type, provides a list of fields in your
data source. Values from the field for which you are creating the filter are compared to
those in the comparison field and filtered out based on the selected operator.

The Add Filter dialog box when filtering a numeric field by comparison to another field is shown
in the following image.
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Adding Prompted Filters to a Visualization

As you create charts or styled tabular content in Db2 Web Query Designer, you may want to
narrow the display of information that is shown. You can do this by creating filters for data
fields in your content. You can also use filters as a way to create custom displays of the data
that you show in your content. For example, you may only want to show revenue information for
specific product categories and models in a given year.

Prompted filters can be created for external content added to a page, in which case any
parameters in that content can be added as filter prompts, or for new content, in which case
the filter affects all new content on the page.

When you add filtered content to a page, you can open the Filters tab on the sidebar and click
Add all filters to page to add the filters to the page automatically, providing interactive controls
that your users can choose from to change the view of data available to them. Filtered content
can also be kept stand-alone, and you can choose to enable parameter prompting, which
requires a user to make a selection before the content displays. There is no limit to the
number of filters that you add, however, as you add more than five filters, all filters may not fit
on your screen. If you are using a carousel filter layout, used for prompted filters added to new
content, you can use the arrow control to scroll over to see any filters that are not visible in the
Filter toolbar, as shown in the following image.

If you are using a columnar layout, which is used for a visualization assembled from existing
content, then filters are split into additional rows as they exceed the number of columns on the
page, as shown in the following image.

You can add prompted filters to a chart or styled tabular content in one of the following ways:

When creating new content, drag a data field to the Filter toolbar below the page toolbar.

When creating new content, right-click a data field and click Add to filter toolbar.
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When creating or interacting with new content, select one or more sections of a chart by
clicking or lassoing them, then click Keep.

When creating or interacting with new content, use the filter options in the In-Document
Analytics menu on the column of a report.

When creating a visualization from existing content, add an item that uses dynamic
parameter filters to the visualization.

Note: You can add data fields to the filter toolbar even if you do not have it displayed in your
view.

You can remove filters from the filter toolbar by clicking the X in the upper-right corner of the
filter, or by right-clicking the filter and then clicking Delete.

You can create a maximum of one filter per measure field, and a maximum of two filters per
dimension field, for individual dimension field values and for an aggregation of the dimension
field. The aggregation of a dimension field can be a count, count of distinct values, or a
percent of count. You can create an aggregated dimension filter by adding the dimension to
your content as a measure, right-clicking the aggregated field in a measure bucket, and then
clicking Add to filter toolbar. If you right-click a field that already has a filter and click Add to
filter toolbar, or drag it into the filter toolbar, the existing filter control expands for you to select
filter values.
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Once you have created filters, you can click them to select default data values and set
selection options for each filter. For example, when you create a filter using a dimension, it
lists the available data values. You can then select the default filter values, as shown in the
following image.

By default, no values are initially selected in the list control, which means that all values are
displayed by default. To select default values, you click the filter control, and begin clicking the
data values that you want to use as the default, then click outside the filter control area to
apply the selection.

If you select one or two values, each selected value is listed by name in the filter control. If you
select three or more values, the filter control shows the number of values selected out of the
total number of available values. If no values are selected, the filter control says All. All
available filter values are reflected in your content. If you select all listed values or click Select
all, then the filter indicates that n of n values are selected. If the values in the field change in
the data source, then the filter does not dynamically update to include them like it would if no
values had been explicitly selected.

The selected values are displayed in the chart at run time by default, and users can select
other values to display them.
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Note: In charts, reports, and visualizations with new content, drop-down list controls and slider
controls using the Detail option have a record limit of 5000 values. Values beyond this limit
are not available for selection in the filter control. There is no record limit for filters in
visualizations assembled from existing content, calendar controls, or slider controls using a
summary aggregation.

When multiple prompted filters for alphanumeric dimension fields are created in a visualization
created with new content, they are chained in all directions, by default. This means that the
selection from one prompted filter control automatically filters and updates the available
values in the other controls, so they only display relevant values. This ensures that you cannot
select filter values that result in no data displayed in the visualization. You can change the
chaining setting from multidirectional chaining to hierarchical chaining, or turn chaining off,
from the Filter options menu.

In pages assembled from existing content, chaining is unidirectional, applied only to filters
lower in the chaining hierarchy than the filter for which you selected values. Filters for fields in
the same hierarchy are chained automatically, and you can drag a field onto another field in
the filter list in the Filters tab to manually make it a child of that filter for chaining purposes.
For more information about filter chaining in new content and pages assembled from existing
content, see Chaining Filter Control Selections on page 39.

When creating prompted filters for new content, you can choose to exclude data values from
the list. To do this, right-click the filter and select Exclude. You can then click the filter control
again, and begin clicking the data values that you want to exclude from the list. Once you have
selected the data values that you want to exclude, your chart refreshes. At run time, instead of
choosing which values to display in the chart, users select values to exclude from the chart.

You can also set a prompted filter for new content to use a single value instead of multiple
values. If you right-click a prompted filter for new content and click Single, when you click the
filter control again, you are only able to select a single value. In filters for existing content, you
will have already defined whether or not the filter is multiselect or single-select.
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If you add a filter using a numeric field, such as a measure, (for example, Cost of Goods), you
can use a slider to adjust the range of data values that display, as shown in the following
image.

Click the filter, and use the slider options on either side to modify the range of data values.
You can set a range using both ends of the slider. To select a single value, set both ends of
the slider to the same value.

The filter for a numeric field is applied after aggregation by default. That means that the filter
is applied based on summed values for all sort values in the chart instead of filtering each row
of the data source before aggregation. You can right-click a new prompted filter and point to
Aggregation to select a different aggregation operation, or select Detail to apply the filter to
each row before aggregation. For more information, see Summarizing Numeric Data Using
Filters on page 46.

If you right-click a new numeric filter and select Greater than or equal or Greater than, you can
select a minimum value for the filter range. The upper limit on the slider is fixed and cannot be
moved. Selecting Greater than or equal includes the value indicated by the slider in the filter,
while selecting Greater than excludes this value. Similarly, if you right-click a numeric filter and
select Less than or equal or Less than, you can select a maximum value to display. The lower
limit on the slider is fixed and cannot be moved. Selecting Less than or equal includes the
value indicated by the slider in the filter, while selecting Less than excludes this value. The
slider displays the greater than (>), less than (<), greater than or equal to (≥), and less than or
equal to (≤) symbols to differentiate your choices.

Note: Selecting the full range of values in the slider includes all values in the filter. The value
indicated by the slider head is not excluded in this case, even if the Greater than or Less than
filter options are used.
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If you add a date field, you can use the date picker window to select a start or end date, range
of dates, and more, as shown in the following image.

You can use a default range available in the list on the left, or select your own range of dates
from the calendar. Click the same date twice to select a single day.

If you right-click a new date filter and select After or Before, you are unable to select a range
using either the preset or custom range options. Instead, use the calendar to select a start or
end date for the filter.

Similar to filtering a numeric field, you can right-click a date filter control and click On or after
or On or before, as an alternative to After or Before, to include the start or end date selected in
the calendar. The After and Before options do not include the selected date in the date range
of the filter.

In addition to the options specific to each type of filter, you can make the filter required. When
a filter is required, filtered content will not load until the user makes a selection for that filter.
To make a prompted filter for new content required, right-click the filter and click Require
selection. To make a prompted filter for existing content required, select the filter control and,
on the Settings tab of the Properties panel, clear the Optional check box.
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You can right-click a filter control for existing content on a page to access formatting options.
For example, you can convert a list control to radio buttons, check boxes, or a button pane,
merge two related controls, and access configuration and format options on the Properties
panel. For more information, see Styling Filter Controls in a Visualization on page 63.

Filtering a Chart with Visual Selections

You can visually create prompted filters by selecting areas of a chart directly from the canvas
as you create it, as well as at run-time. This is called on-chart filtering. Since on-chart filtering
is performed based on visual selections on a chart, they are quick and intuitive to create. On-
chart filters created from one item immediately affect all other content created on the page,
allowing you to see the impact of your filter immediately. On-chart filtering is available from
pages containing one or more new content items, and from stand-alone charts created using
the AHTML output format.

On-chart filtering is enabled in applicable content types by default. To disable on-chart filtering,
open the Filter options menu and deselect Use content as filters.
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To use on-chart filtering, select one or more areas of a chart by clicking a single section or by
clicking and dragging, or lassoing, an area of the chart. The selected sections of the chart are
highlighted, and a tooltip appears with information about the selected area, as shown in the
following image.

From the tooltip, you can filter the entire visualization for the data that you selected in the
chart. Click Keep to create a prompted filter for the selected values, or click Exclude to create
a filter that excludes the selected values.
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You can create several filters using on-chart filtering to further refine the data that you display
in the visualization. Each of these filters affects every item on the page. When a filter is
created, it is added to the Filter toolbar. If the filter applies to a single dimension, you can click
the filter label in the toolbar to edit it. If the filter is applied to multiple dimensions, such as a
bar chart with one dimension in the Horizontal bucket and another dimension in the Color
bucket, then the filter is not editable from the Filter toolbar. However, you can point to it to see
a tooltip listing the filter selections, as shown in the following image.

You can right-click the filter label at design time to delete the on-chart filter or swap between
keeping and excluding the selected values. You can also delete a filter created with on chart
filtering by selecting an area of the chart and clicking Remove Filter on the tooltip, or by clicking
the X on the filter control in the Filter toolbar. The visualization restores the values previously
hidden by the on-chart filter.

On-chart filtering works similarly at run time. When you run a page created with new content,
you can click or lasso different areas of a chart to dynamically filter the entire page.
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Chaining Filter Control Selections

When a content item or page includes multiple filters, chaining ensures that those filters
always return valid values to your content. When you select a value from one of the filter
controls, the other controls can be filtered and updated based on the value that you select, if
chaining is applied For example if you have a filter for Sale Quarter chained to a filter for Sale
Month, then if you select Q1 from the Sale Quarter filter, the Sale Month filter updates to show
only the months of January, February, and March, and automatically excludes any month
values that were not in Q1.

Two different chaining behaviors are available: multidirectional and hierarchical. When multiple
prompted filters for alphanumeric dimension fields are created in a visualization created with
new content, they are chained multidirectionally, by default. This means that the selection from
one prompted filter control automatically filters and updates the available values in all other
controls for alphanumeric fields, so they only display relevant values. This ensures that users
cannot select filter values that result in no data displayed in the visualization, regardless of the
order and arrangement of the filter controls. To select a value that has been hidden because of
chaining, clear any other filters that may have resulted in the value being unavailable. Note
that on-chart filtering also affects the available filter values when multidirectional chaining is
enabled.
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For example, the following image shows a chart with multidirectional filter chaining enabled.
Notice that, since the filter for Sale Day was set to 31, only months with 31 days are shown in
the drop-down list for Sale Month.

If you make selections in one filter control, and then make selections in another chained filter
control that make some of the original values unavailable, those originally selected values are
restored when the other filters are cleared. For example, if you set the Sale Month filter to
September and December, and then set the Sale Day to 31, September is no longer visible in
the Sale Month control, since it only has 30 days. Only December is selected. When you clear
the Sale Day control, both September and December are selected once again in the Sale
Month control.

Full multidirectional chaining is only applied to list controls in new charts and reports that are
standalone items or created as part of a page. Calendar and slider controls are not chained.
While slider controls and preset ranges in calendar controls update to reflect the current range
of data, similar to chaining, the values selected using a slider or calendar do not affect the
other controls.
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You can change the chaining setting for filters in new content items to use hierarchical

chaining or no chaining by clicking the Filter options menu  and selecting Link hierarchies
or Do not link filters, respectively. The option to change chaining behavior is only applicable to
stand-alone content or content created within a visualization.

Hierarchical chaining is based on drill levels in your metadata. When you select a filter value,
chaining is applied to fields that are lower in the same metadata hierarchy. Filter controls for
fields that are higher in the same hierarchy are not affected by filter selections when using
hierarchical chaining, nor are filter controls for fields that are not in the same hierarchy.

Hierarchical chaining is the default behavior for filter controls that are added to a page from
external content. When external content is added to a visualization, hierarchical chaining is
applied automatically to any content with WHERE filters using a WITHIN phrase. Db2 Web
Query Designer automatically adds the WITHIN phrase to filters from the same metadata
hierarchy, so hierarchical chaining is enabled for content items created in Db2 Web Query
Designer by default when they are added to a page as external content.

You can also manually apply hierarchical chaining relationships to filter controls from the
Filters tab on the sidebar when assembling a page from existing content. Drag one parameter
in the list on the Filters tab onto another parameter to make it a child of that filter control. You
can create a multi-level chaining hierarchy so that selections from one filter apply chaining to a
second filter, and selections from the second filter apply chaining to a third filter. To remove a
chaining relationship, in the parameter list, drag a filter onto the name of the content item
from which the filter was generated. Selections from other filter controls will no longer affect
the available filter values for that parameter.

Applying Prompted Filters From External Content

Importing a filter from external content in Db2 Web Query Designer is a quick and intuitive
process. Additionally, parameter filters added to a page from existing content can be
rearranged and styled with options unavailable to filters created for new content in a page.

Whenever you add a parameterized content item to the canvas, such as a chart or report that
uses a prompted filter or dynamic parameter, the parameters are recognized and you can
filters for them automatically. A badge is overlaid on the Filters tab on the sidebar, as shown in
the following image.

The Filters tab provides options to add filters to your page and apply chaining to them.
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Open the Filters tab and then click Add all filters to page to create filters for all identified
parameters. Alternatively, right-click a parameter in the list to create a single filter control. If
the Filter toolbar is visible on the page, you can also right-click a cell and then click Add filter
controls to open the Add Filter Controls dialog box. You can select the particular filters that you
want to create, quickly exclude optional parameters from filter creation, see which filters will
be multiselect, and change the type of control that each filter uses. The Add Filter Controls
dialog box is shown in the following image.

After you add filters from external content to a page, you can right-click a filter control to
access formatting options. For example, you can convert a list control to radio buttons, check
boxes, or a button pane, merge two related controls, and access configuration and format
options on the Properties panel.

As an alternative to using the Filter toolbar, or in addition to it, you can also add a grid
container to a page assembled from existing content by dragging it from the Resources panel
when you select the Container tab on the sidebar. A grid container includes multiple cells into
which filter controls can be placed. You can also move the original filter toolbar or have it
display in a modal window by selecting the entire page and then clicking one of the filter
location options on the Settings tab of the Properties panel.
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To see which filters apply to which external content items, click Info on the Visualization
toolbar. Each content item on the page lists the parameters by which it is filtered. The chart
displayed in the following image is affected by filters for six fields, listed under Parameters/
Filters.

Procedure: How to Add Filters From Existing Content to a Page

When you bring existing, parameterized content into a page, you are prompted to create filter
controls for each parameter. Once created, these controls can be modified with a set of
additional options that are not available when creating new content items.

1. Open Db2 Web Query Designer. On the default Db2 Web Query Home Page, click the plus
button and then click Assemble Visualizations.

Db2 Web Query Designer opens in a new browser tab.

2. In Db2 Web Query Designer, select a template for the page. You can use a predefined
template, or select Blank to build the page from scratch.

3. With the Content tab selected on the sidebar, drag a parameterized item of your choice
from the Resources tree to the canvas.

A badge appears on the Filters tab icon on the sidebar, indicating that there are unbound
filters.

4. Optionally, add more content.

1. Creating Reports

Using Db2 Web Query  43



5. Click the Filters tab on the sidebar. Click Add all filters to page to create controls for all
listed parameters, or right-click each parameter for which you want to create a filter
control, and click Add to page.

The filter bar appears above your content with the controls that you chose to create.

6. Optionally, customize your filter bar as described below.

Change the location of the filter bar from below the page toolbar to above it or into a
modal window. Select the entire page and, in the Properties panel, on the Settings tab,
select Below Header, Above Header, or Modal.

Move filter controls to a filter grid. When assembling a page from existing content, you
can create a filter grid by dragging a grid container from the Resources panel with the
Container tab selected. You can then resize and reposition the filter grid to customize
where the filter controls should display on your page.

Right-click a cell to access shortcut menu options, as shown in the following image.

To right-click a cell, right-click the margin above or to the left of a filter control.

The available options are:

Add filter controls. Opens the Add Filter Controls dialog box, where you can choose
from the list of available controls and add them to the filter grid.

Note: If all available filters display on the page, the Add Filter Controls setting is
inactive.

Insert row above. Inserts an empty row above the current row in the filter grid.

Insert row below. Inserts an empty row below the current row in the filter grid.

Format. Opens the Properties panel to the Format tab, where you can customize
the grid style and cell alignment.
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Delete cell. Deletes the current cell.

Delete grid. Deletes the entire filter bar.

Right-click a control to access shortcut menu options, as shown in the following image.

The available options are:

Edit label. Selects the label text for editing.

Note: Another way to edit a control label is to double-click the filter label, type the
new text, and press the Enter key.

Convert. Opens the Convert Control To dialog box, where you can choose between
various control types.

You can convert a list control, created for alphanumeric fields, to radio buttons if
single-select, check boxes if multiselect, or a button panel. You can convert a
single-headed slider, created for single-select numeric fields, to an input box.

Settings. Opens the Settings tab of the Properties panel, where you can customize
control configuration options.

Format. Opens the Format tab of the Properties panel, where you can customize
control styling options.

Delete control. Removes the filter control from the visualization.

Drag any filter cell to a new location in the grid to reposition or reorder the filter
controls.
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Multi-select two related controls, right-click one of them, and then click Combine to
combine the two controls into one. An example of two combined controls is shown in
the following image.

The Combine option only applies to single-select date and numeric slider controls. They
can be combined into a single control with a start and end point.

Drag a control into a cell with other controls. This action puts two separate controls
into one cell. The drag marker is shown allowing you to position one controls in front or
behind another control. You can separate the controls again by dragging one control
out of the cell.

7. Save your changes.

Summarizing Numeric Data Using Filters

When you create a filter for a measure field in new content, you can choose to filter by
aggregated values, using a Summary filter, or by individual records, using a Detail filter. This
enables you to review data from a high level or based on a more granular view.

Adding Filters to a Visualization

46  Information Builders



To specify one of these options in a new prompted filter, when you place a measure on the
Filter toolbar, right-click it and point to Filter on to access the Detail and aggregated filter
options, which are shown in the following image.
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To choose between detail and aggregated filter options when creating a static filter, drag a
measure to the Filter bucket and select an option from the Apply aggregation drop-down menu.

Summary filters are indicated by an aggregation prefix operator on the filter control label.

The Summary option, which is the default for measure fields, allows you to select records
based on the summed, aggregated value of a field. All values for the chart, report, or page are
calculated, and then the aggregated values are filtered based on whether they meet the filter
requirements. For example, if you create a chart that shows Revenue sorted into Product
Categories, you can use a summary filter to display only the Product Categories that meet the
selected filter requirements.

If you create a new summary filter in a visualization with multiple content items, the minimum
and maximum values available in the filter control are the minimum and maximum values
across all combined sort fields in the entire visualization. For example, if you created a chart
that was sorted by Product Category, and then added a second chart that was sorted by Sale
Year and colored by Sale Quarter, then the values in the summary filter would reflect the range
of values for each product category and each combined sale year and sale month. In the
following image, the minimum available value for the summary filter on the Revenue field is
11,047,133, which is the revenue from Q1 2014 in the bar chart on the right. This is the
smallest value on the page. The maximum available value, 291,294,934, is the revenue for
stereo systems in the pie chart on the left. This is the largest value on the page.
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All of the other values in the pie chart and the bar chart on the page fall between these two
points. As a result, certain summary filter selections may exclude all values from one chart,
but not another.

You can also filter using Detail values, which represent each record of your data source. In this
case, filtering occurs before the values are calculated for each sort value. If you create a chart
that shows Quantity Sold sorted by Product Category and add a Detail filter, the individual
record values from the data source are filtered based on whether they meet the filter
requirements, and then sorted into product categories and aggregated to display the quantity
sold for each.

Consider the following two charts, each of which uses a filter for Revenue greater than
$10,000. The first chart uses a Summary filter, so it is filtered after aggregation. It displays
Revenue values for every product category that had over $10,000 in total revenue. Each of the
seven product categories met this criterion, and are therefore displayed in the chart, as shown
in the following image.
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In the second chart, the Summary filter has been changed to a Detail filter where Revenue is
greater than $10,000. This filter is applied before data aggregation. Since each record in the
data source represents a single sale, the data is filtered for individual sales that earned
revenue of over $10,000. Those values are then grouped by Product Category into the chart
shown in the following image.

In this case, the only individual sales for more than $10,000 were for camcorders and
televisions.
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In addition, when working with numeric filters, you can select the type of aggregation to be
used in a Summary filter. By default, a Summary filter, created using the Summary option,
uses the sum aggregation. You can also apply standard aggregation methods including
average, count, count distinct, minimum, and maximum to a Summary filter. Selecting one of
these options filters your content for aggregated values matching the specified criteria,
indicated by the label on the filter control, as shown in the following image of a filter control
using the average aggregation method.

If you create a filter for a field in your chart or report that already uses a prefix operator
aggregation, by dragging the field from a bucket to the filter toolbar or by right-clicking it in a
bucket and clicking Add to filter toolbar, a Summary filter is created with the prefix operator
aggregation applied.

If the field with the prefix operator is a dimension field, which can use the count, count
distinct, or percent of count prefix operator aggregations, then you can create two filters for the
field, one for the non-aggregated dimension field and one for the aggregated version of the
field.

If your request produces a single aggregated value before applying a Summary filter, such as
when there are no sort values, the filter control shows a single Summary value instead of
providing a range. If you point to the filter value on the Filter toolbar, a tooltip appears that
says, Summary filter irrelevant. Change to Filter on Detail or add a sort field to your request.

If you create a Summary filter and then changes are made to the request such that the
minimum or maximum value on the Summary filter range falls outside the range of values in
your data, then that filter value appears in red in the control. If you point to it, a tooltip
indicates that it is outside the range of your data. The filter is still valid, but may not be
applicable to the current state of your content. Similarly, when creating a static filter, you can
type a value that is outside the range of values in your data. In this case, the text box
displaying the value is outlined in purple and a message indicates that the value is out of
range.
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If you create a numeric range in a static filter where the minimum value is greater than the
maximum value, the filter is not valid, and you cannot save it. A warning appears alerting you
that the start and end points are invalid.

Working With Required Parameters

By default, when you create a prompted filter in Db2 Web Query Designer, the filter is optional.
You can right-click a new prompted filter and select Require selection, or select a prompted
filter for existing content and clear the Optional check box on the Settings tab to make it
required. This means that users must select a value at run-time before affected content on the
page loads. Required controls from external content are marked in red, prompting you to make
a selection for the request to be processed. The image below shows an example of a required
filter control.

Procedure: How to Convert an Optional Filter Control in an Assembled Page to a Required One

1. In Db2 Web Query Designer, add filters to a page, as described in Applying Prompted
Filters From External Content on page 41.

2. Select an optional filter control and open the Settings tab on the Properties panel.

Be sure to select the filter control itself. If you click just outside the filter control, you will
select the cell containing the control, which can also be styled and formatted.

3. In the Control Settings area, clear the Optional check box to make the control required.
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The filter control is marked in red and the Make a selection text displays inside the control
field.

4. Optionally, to change the default text from Make a selection to a prompt of your choice,
change the value of the Placeholder text setting on the Properties panel.
The default text in the required control changes.

5. If the filter was created for an alphanumeric field, on the Settings tab, in the Data Settings
area, disable the Show All option setting.

6. Click the Run in new window button.

Your content opens in a new browser tab or window. The content affected by the filter
does not initially load. You must select a filter value first.

7. Select a value for the required filter control.

The content refreshes to reflect your selection.

8. Return to Db2 Web Query Designer and save your changes.

Working With Single and Multiple Select Lists

In Db2 Web Query Designer, list controls are created for alphanumeric fields and numeric
dimension fields. There are two types of list controls in Db2 Web Query Designer:

Single Select List. Allows you to pick a single value at run time.

Multiple Select List. Allows you to pick multiple values at run time.
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An example of a single select list control is shown in the following image.

Once you have made a selection in a single select list, your content instantly refreshes to
reflect that selection.
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An example of a multiple select list control is shown in the following image.

Once you have made all your selections in the multiple select list, you must click outside of the
control for the content to refresh.

If the prompted filter was created in a visualization with new content, you can switch between a
single and multiple list control by right-clicking the control and selecting Single or Multiple. If
the prompted filter was created for external content, the parameter on which it is based is
already defined as single- or multiselect.

List controls for new content include a search feature to make it easy to select the filter values
you want to use. To add or remove the search box for a filter for external content, select or
clear the Search check box on the Settings tab of the Properties panel. Once search is enabled
in the control, simply start typing any word or syllable and all values that contain it will display.
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If a list contains 200 or more values, the paging feature is added to the bottom of the control.
When paging is active, 10 values display per page. An example of a long list with the paging
feature enabled is shown in the following image.

List controls for new content also include the Select all and Clear buttons. These are especially
useful when you need to eliminate just a few values from your results. You can click Select All,
clear the values that you need to eliminate, and click outside of the control to refresh your
content. These can also be added to multiselect list controls for existing content by selecting
the Selection controls option on the Settings tab.

Once you've typed a search term, you can use the Select all button to select all search results,
as shown in the following image.
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Note that the Select All option selects all values in the control. If the control does not contain
all field values, then those values won't be included in the filter. Additionally, the filter
selection will not update to include new values added to the data source. To ensure that all
values for the selected field are included in the filter, clear the filter selection. All displays on
the filter control, indicating that all values are used in the filter.

Note: In charts, reports, and visualizations with new content, drop-down list controls and slider
controls using the Detail option have a record limit of 5000 values. Values beyond this limit
are not available for selection in the filter control. There is no record limit for filters in
visualizations assembled from existing content, calendar controls, or slider controls using a
summary aggregation.

Working With Slider Controls on a Page

A slider control is a horizontal track with a marker or markers that you can slide between a
minimum and maximum value. This versatile control is often used to choose a numeric value
within a fixed range. An example of a slider control is shown in following image.

Procedure: How to Create a New Slider Control Using Db2 Web Query Designer

1. Open Db2 Web Query Designer. On the default Db2 Web Query Home Page, click Visualize
Data.

Db2 Web Query Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

Once you select a data source, Db2 Web Query Designer loads with options to create a
single content item.

3. Add a dimension field and, optionally, a measure field to your chart.

If there are no dimension values in the chart by which to aggregate the numeric values on
the slider, a tooltip indicates that slider selections are not relevant.

4. Drag a measure field into the Filter toolbar.
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A slider control appears, allowing you to select default values for the filter parameter, as
shown in the following image.

5. Set the default range of values for the filter.

6. Optionally, right-click the control on the Filter toolbar and click Greater than, Greater than
or equal, Less than, or Less than or equal to select only the minimum or maximum value
for the filter.

When a parameter using one of these options is added to a page in Db2 Web Query
Designer, the control is a slider with a fixed start or end point.

Procedure: How to Create a Slider Control From Content Created in InfoAssist

1. On the default Db2 Web Query Home Page, in the Workspaces view, in the InfoAssist
section of the Action bar, click Report or Chart.

The Open dialog box opens.

2. Select a data source in the Open dialog box and click Open.

InfoAssist opens.

3. Create a report or chart.

4. On the Data tab, click Filter.

The Create a filleting condition dialog box opens.

5. Create two optional simple parameters representing minimum and maximum values and
make them optional.
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In this example we create the minimum and maximum parameters for the MPG field in the
car report. MPG should be greater than or equal to the minimum MPG parameter, and less
than or equal to the maximum MPG parameter. An example of the completed filtering
condition is shown in the following image.

6. Save your changes and exit InfoAssist.

7. On the Home Page, right-click your new content item, and then click Edit with text editor.

The Text Editor window opens.

8. Edit the syntax by providing the data range values.
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An example of the modified syntax is shown in the following image.

9. Save your changes and exit the Text Editor.

10. Create a new visualization using existing content. On the + menu, click Assemble
Visualizations.

Db2 Web Query Designer opens in a new tab.

11. Select a template for your visualization.

12. In Db2 Web Query Designer, in the Resources panel with the Content tab selected on the
sidebar, drag your new content item to the canvas.

A badge appears on the Filters tab of the sidebar, indicating that filters are available to
add to the page.

13. Click the Filters tab on the sidebar, and then click Add all filters to page.
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The slider controls display in the filter grid, as shown in the following image.

14. Optionally, combine two controls together. Multi-select both controls, right-click one of
them, and then click Combine.

Your controls are combined. You can double-click the label to edit it to reflect your new
combined control. An example of the combined slider control is shown in the following
image.

15. Save your changes.
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Working With Date Controls

Parameters that contain dates are recognized by Db2 Web Query Designer as date controls. An
example of the date controls for external content on the page is shown in the following image.

In this example, each of the controls is associated with a distinct parameter. One parameter
uses the Greater Than WHERE condition, the other parameter uses the Less Than WHERE
condition.

Optionally, when creating a visualization with external content, you can combine two date
controls into one date range control. To do so, multi-select two date controls and then click
Combine. An example of a combined date range control is shown in the following image.

When creating new content with a date filter, the date control is automatically a combined
control that allows you to select a date range.
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The user can select a custom range of dates from the calendar, as shown in the image, or use
any of the preset options to select a common date increment. Click the same date twice to set
the date range to a single day.

The calendar feature inside a date control allows you to select a specific date value. Once you
pick a specific date, it is always spelled out, so that it can be supported by all internationalized
applications.

Styling Filter Controls in a Visualization

When creating a page from external content, you can configure the properties of the filter
toolbar, a filter grid panel, or single filter control by using the Properties panel, which is
context-sensitive. For example, when you click a filter cell on the toolbar or in a filter grid, the
cell style properties open in the Properties panel. When you click a filter control within a cell,
the configuration and style properties for this control open in the Properties panel. You can
access properties for the entire Filter toolbar or a filter grid by selecting it from the outline.
When creating a page from new content, a smaller set of options are available for a filter
control or for the filter toolbar.
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The Properties panel consists of the Settings tab and the Format tab. The Settings tab
includes options to configure the behavior of the Filter toolbar, a filter cell, or a filter control.
The Settings tab on the Properties panel for a filter control created for external content is
shown in the following image.
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When you select the entire page, if it was assembled from existing content, you can change
the position of the filter toolbar using the following options:

Include Page Filters. Select this check box to add a filter toolbar to the page, even if no
filters have been added yet. Clear this check box to remove the filter toolbar.

If Include Page Filters is selected, you can select one of the following options to change the
position of the filter toolbar:

Below Header. The filter toolbar is placed below the page toolbar and header. This is
the default.

Above Header. The filter toolbar is placed above the page toolbar and header.

Modal. The filter toolbar is accessible in a modal window overlaid onto the page. Click
the Show filters button on the page toolbar to open the modal window and make filter
selections.

When the Filter toolbar or a filter cell is selected, the Settings tab includes two properties:

ID. Contains a read-only unique CSS identifier.

Classes. Allows you to add one or more custom CSS classes that you can reference in
custom JavaScript and CSS code.

Filter controls created within a page have different configuration and styling options than filter
controls added to the page from referenced, external content. When you select a filter control
that you created directly within the page, the Settings tab contains the following properties:

General Settings. This section includes the following options:

Type. Displays the type of the control.

ID. Contains a read-only unique CSS identifier.

Classes. Allows you to add one or more custom CSS classes that you can reference in
custom JavaScript and CSS code.

Tooltip. Displays a tooltip when you hover over the filter control.

When you select a filter control that was generated from external content using the Filters tab
on the sidebar, the Settings tab contains the following properties:

General Settings. This section includes the following options:

Type. Displays the type of the control.

Tooltip. Displays a tooltip when you hover over the filter control.
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Global name. Designates a global name to the control, allowing you to synchronize
control values on different pages.

Control Settings. This section includes the following options:

Optional. Toggles between optional and required control.

Allow reordering. If selected, allows you to reorder values inside the control at run time.
The default order is alphabetical. This property is only available for check box controls.

Placeholder text. Enables a configurable placeholder text that you can show users
inside a required control when it has no value. The default text is Make a selection. This
property is only available for drop-down list controls.

Note: The Placeholder text property is only used for required controls. The placeholder
text appears before a selection has been made. To change the default text for an
optional control, enable the Show All option property and type a value for the Display
text property. The display text option in the control represents all values.

Search. Adds a search field to the filter drop-down menu. This option is available for
drop-down list, check box, and radio button controls.

Note: If the select list contains 50 or more values the Search option is enabled
automatically.

Selection controls. Adds Select all and Clear buttons to the filter drop-down menu. This
property is only available for multiple select lists and check box controls.

Note: The Selection controls and Show All options cannot be selected at the same time.

Data Settings. This section includes the following options:

Show All option. Adds an All option to the control that the user can select.

Note: Choosing this option results in the parameter receiving a _FOC_NULL value. If this
parameter is used in a WHERE condition, it results in the WHERE condition being
removed from the request and all data values for this field displaying the page.

Display text. Allows you to specify a custom value for the Show All option in the control.
The default text is All.

Note: The Display text property is available when Show All option is selected. The
display text option in the control represents all values. To supply a placeholder value for
required controls that appears before a selection is made, use the Placeholder text
property.
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Default value. Displays the default value of the control. For optional parameters you can
edit this field and override the control value.

Parameters. Shows the name of the parameters that are associated with this control.

Relationship Settings. Shows chaining relationships that affect the values displayed in the
filter, namely the parent control.

When creating a visualization using external content, the Format tab of the Properties panel
provides layout and styling options for the Filter toolbar, a filter cell, or a filter control. These
options differ depending on the origin of the filter and the item selected. Format options are
not available for new prompted filters created in a visualization.
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The Format tab of the Properties panel, for the filter bar on the Filter toolbar or in a grid
container, is shown in the following image. You can use these options to change the layout of
the cells in the Filter toolbar or grid container, and change the theme style it uses.

The Format properties for a bar are:

Grid Type. Controls the grid layout of the filter bar. The options include 1-Column, 2-
Column, 3-Column, 4-Column, and 6-Column.

When you are using a columnar layout and the number of filters exceeds the number of
columns, the extra filter controls are added to new rows in the Filter toolbar. In the carousel
layout, you can use the arrows on either side of the Filter toolbar to scroll to additional filter
controls.
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Grid Style. Controls the style of the filter grid. The available styles are defined in the theme
used for the page. When you select a style for a cell, the entire Filter toolbar is affected.

The Format tab for a cell is shown in the following image.

When you configure these properties, you modify the alignment of a control or other object
within a cell. Cell format properties are only available for cells in the columnar grid or toolbar
layout used in a visualization with external content. The cell and filter control in the carousel
style layout used in a visualization with new content are not separate components, so the cell
cannot be selected for formatting.

The properties for a filter cell are:

Cell Content Alignment. Controls the alignment of the label and control inside the cell. The
options include top, middle, bottom, left, center, and right. These options are available
when using a columnar filter grid layout.
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The Format tab for a filter control created for external content is displayed in the following
image. You can modify the positions of labels in a control, define the alignment, and set the
object width.

The style properties for filter controls in a page with external content are:

Label Position. Controls the position of the filter label in the relation to the control. The
options are above, right, left, and no label.

Label Alignment. Controls the alignment of the filter label. The options are left, right, and
center.

Direction. Controls the alignment of the elements inside the control. This property is
available for radio button, check box, and button set controls. The options are horizontal
and vertical. The vertical option is enabled, by default, when the control has five or more
values.

Label/Control Split. Controls the space ratio between the label and control inside the cell.
This option is only available when the label position is set to right or left.

Control Object Width. Sets the width of the control in relation to the filter cell. The options
are:

Auto. Adjusts the width of the control automatically to accommodate the name of each
value.
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Max. Fills the entire filter cell. This is the default value.

Percentages. Set the control width to various percentages, as they relate to the filter
cell.

Control Object Height. Sets the maximum height of the control. If the list of elements
exceeds the maximum height of the control, a scrollbar is added to this control. This
property is available for radio button, checkbox, and button set controls when their
Direction property is set to vertical. The default value is 150px. You can change this value
as necessary.

Prompted filter controls created in a visualization with new content always use a predefined,
simple filter style. No format options are available for these controls.

Choosing an Event Model for Your Page Filter

When assembling a visualization from existing content, WeDb2 Web QuerybFOCUS Designer
supports two event models for passing parameters to your page content:

On-selection Change. Whenever you change a value of any filter control on the page,
parameterized content refreshes to reflect your selection. This model is enabled, by
default.

Submit Button. After you make all desired changes to filter controls on the page and click
the Submit button, parameterized content refreshes to reflect all your selections. This
model can be enabled by dragging a Submit button from the Control tab on the sidebar into
the filter grid.

Procedure: How to Use On-selection Change Filters

1. Add filters to a page as described in Applying Prompted Filters From External Content on
page 41.

2. Click the Run in new window button.

Your content opens in a new browser tab or window, allowing you to interact with content
and filters. If your page content contains default values, page filters and page content run
in parallel, which results in a faster loading time.

3. Make filter selections.

Each time you make a selection, the content refreshes to reflect it.
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Note: Notice that, if you have parameters that come from the same field hierarchy in your
data source, the filter controls are chained in such a way that each selection automatically
reflects the available choices in other filters. In our example, we set Category to
Televisions. Now, the Product Model filter only shows models of televisions, as shown in
the following image. Db2 Web Query Designer chains controls automatically, if the
parameters are defined in the metadata layer with the WITHIN keyword to relate them.

4. Return to Db2 Web Query Designer and save your changes.

Procedure: How to Use Filters With a Submit Button

1. Add filters to a page assembled from existing content, as described in Applying Prompted
Filters From External Content on page 41.

2. From the Resource selector, click the Controls tab, and then drag the Submit button onto
the filter grid. This can be the filter grid in the Filter toolbar, or in a grid container.

The Submit and Reset buttons display in the filter grid.

3. Optionally, customize the Submit and Reset buttons in any of the following ways:

Align the Submit and Reset buttons by selecting the cell in which the buttons reside
and customize the Cell Content Alignment option on the Format tab of the Properties
panel. In this example, we selected Align control bottom and Align control center.

Change the label text in either button by double-clicking it and then typing a new label.
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Add a tooltip to the buttons by selecting each one and populating our the Tooltip field
on the Settings tab of the Properties panel.

Customize the width of the buttons in relation to the filter cell by selecting one of the
options under the Control Object Width property. In this example, we selected 50%.

Note: You can delete one or both buttons by right-clicking them and clicking Delete.

4. Click the Run in new window button.

The content runs in a new browser tab or window, allowing you to interact with content and
filters.

5. Make filter selections. Your parameterized content does not update immediately.

6. Click Submit.

The content refreshes to reflect all your selections upon clicking the Submit button, as
shown in the following image.

7. Click Reset.

The filters return to their default values.

8. Optionally, click Submit again to refresh the content with the default values.

Note: If you deleted the Reset button in the previous step, you must select default values
manually, and then click Submit to return to the default state. Alternatively, you can click
the refresh button on the page toolbar to refresh all content and filter controls on the
page.
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9. Return to Db2 Web Query Designer and save your changes.

Using Global Name to Synchronize Filter Controls

The Global Name property is a powerful tool that allows you to quickly synchronize filter control
values between different pages. The Global Name property is configured on the Settings tab of
the Properties panel for a filter control in an assembled page. Once enabled, it allows you to
match your filter selections across multiple pages at run time within the same browser
session. The global name can be used to synchronize filter control selections across multiple
pages.

Procedure: How to Configure Global Name Filter Control Property

1. In Db2 Web Query Designer, add filters to a page using existing content, as described in 
Applying Prompted Filters From External Content on page 41.

2. Click a filter control that you want to synchronize.

3. On the Properties panel, in the Settings tab, populate the Global Name field, as shown in
the following image.
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Note: You can choose any text as a global name for your control. Combined controls, such
as date ranges and slider controls, have a single global name property.

4. Optionally, repeat step 3 for all the filter controls that you want to synchronize.

5. Save the page.

6. Create a second page, populate it with parameterized content, and add the same set of
filter controls as you did in step 1.

Note: To streamline this process, you can use the Save As option to create a new version
of the existing page, leave the configured filters intact, and replace the content on the
canvas. Make sure the Global Name values are identical between the filter controls on
both pages.

7. Save the second page and exit Db2 Web Query Designer.

8. Run one of your newly created pages.

9. Select filter control values.

An example of the filter control selections is shown in the following image.

10. Run the second page.
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The page runs with the same filter control values as the ones you have selected on the
previous page, as shown in the following image.

11. Optionally, change the filter control values on the second page and see how they
synchronize with the ones on the first page.

Bookmarking Control Selections in a Page

Bookmarking allows users to save filter control selections and other run-time content
customizations that they make in a page so that they can easily reapply them when they run
the page again later. This is especially useful when there are many filter controls on a page
that a user may want to apply each time they access it. Bookmarks are personal to each user
and can easily be created and deleted as needed.
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Bookmarking is enabled automatically once the page has been saved, and is available in
authored pages created with new content and in assembled pages built from existing content.
To add a bookmark, make some filter selections when running a page, and then click the

Bookmarks button , which appears on the page toolbar at run time. You are prompted to
type a name for the bookmark. Click OK to apply it. Once applied, the bookmark is added to
the list, which you can open by clicking the drop-down menu arrow next to the Bookmarks
button. Select a bookmark from the list to refresh the page and apply the associated set of
filter values. The bookmark list also includes the Original page option, which reloads the page
with the default filter values selected. From the bookmark list, you can also use the menu for
each existing bookmark to rename or delete the bookmark, or make it your personal default
set of filter values when you load the page, as shown in the following image.

Each user can create a maximum of ten personal bookmarks for a page. If you reach this limit
on a page, delete an existing bookmark to add a new one. The Original page bookmark is
always available and cannot be deleted.
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Bookmarks also save certain user customizations made in the page. For example, if you use
on-chart filtering in an authored page at run-time to create a new filter, you can create a
bookmark to save it. In authored pages, you can also change the filter condition from included
values to excluded values and change the aggregation operation, and in assembled pages, you
can change the content that displays in unlocked containers. All of these changes are saved
when you create a new bookmark.

Setting Dynamic Default Values for Filter Controls

When assembling pages from external content, you can personalize default values for filters in
a page based on users or conditions. This feature uses an amper-amper (&&) global variable to
specify the default option for a filter control. You can then use variables, functions, and
conditions to set the values of these global variables. For example, you can set the Region
value for a user, using the && global variable, and link it to the filter control to show their
region as the selected value, or you can base the default values for a calendar control on the
current date so that they always show a relevant, relative date range.

Procedure: How to Personalize Default Values for Filter Controls

You can use global variables to dynamically set the default values of filter controls based on
the user who is running the page.

1. Start by creating a FOCEXEC which specifies the global variable and the default values. In
this example, we are setting default values for different users for the Region control.

a. On the default Db2 Web Query Home Page, in the Workspaces area, on the Action
bar, click the Other tab, and then click Text Editor.

The New Text Resource dialog box opens

b. In the New Text Resource dialog box, click FOCEXEC (fex).

The Editor opens.

c. Add the following FOCEXEC code to set the global variable:

- &&DEFREGION
-SET &&DEFREGION= IF &FOCSECUSER EQ user1 THEN 'North America' ELSE
-IF &FOCSECUSER EQ user2  THEN 'EMEA' ELSE  'South America'

d. Save your changes and close the Text Editor.

e. Publish the FOCEXEC.

2. Bring the global variable in effect by either running the FOCEXEC or mapping its path in the
Administration Console for it to be run when the user signs in.
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To map the FOCEXEC you just created in the Administration console, add the FOCEXEC
path to the Paths to be executed on user Sign-in field in the Other section under Application
Settings. The FOCEXEC path name can be copied from the Properties panel in the Home
page.

3. Assemble a page from existing content, as described in the Visualizing Data Using Db2
Web Query Designer technical content.

4. Populate your new page with the content that features the Region parameter and add the
Region filter to the canvas, as described in Adding Prompted Filters to a Visualization on
page 30.

5. Click the Region filter and, in the Settings tab, under Data Settings, type the default value
variable that you created in the FOCEXEC (in this case, &&DEFREGION).

The following image shows an example of the Default value property populated with the
variable.

6. Save, publish, and run your page.
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The default value for the Region filter control is North America, as shown in the following
image.

7. Sign in to Db2 Web Query as one of the users mentioned in the FOCEXEC.

8. Run the same page.
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The following image shows an example of the user with the username user1 running the
page. The default Region value now is EMEA.

Procedure: How to Set a Dynamic Default Range for a Calendar Control

A calendar control in a page assembled from existing content is a combined control that allows
you to filter for a date range by selecting a start date and an end date. You can use date
functions to set global variables for the start and end date to a fixed length of time from the
current date, then use those global variables as the default start and end date values for a
calendar control.

The calendar control default dates must be entered using the full month name, for example,
December 31 2019.

1. Start by creating a FOCEXEC procedure that specifies global variables for the default start
and end dates. In this example, we will make the default start date a week before today,
and the end date today.

a. On the default Db2 Web Query Home Page, in the Workspaces area, on the Action
bar, click the Other tab, and then click Text Editor.

The New Text Resource dialog box opens.
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b. In the New Text Resource dialog box, click FOCEXEC (fex).

The Db2 Web Query Editor opens.

c. Add the following Db2 Web Query code to set the global variable:

-SET &LASTWEEK = AYMD(&YYMD, -7, 'YYMD');
-SET &&FROM_DATE = CHGDAT('YYMD', 'MDYYX', &LASTWEEK, 'A17');
-SET &&TO_DATE = CHGDAT('YYMD', 'MDYYX', &YYMD, 'A17');
-DONE

Three variables are defined in this FOCEXEC: &LASTWEEK, &&FROM_DATE, and
&&TO_DATE. &LASTWEEK is a variable that provides the date from one week ago. It
does need to be used directly in the calendar control, so it is not created as a global
variable. &&FROM_DATE and &&TO_DATE need to be saved for use as default values
in the calendar control in our page, so they are created as global variables.

&LASTWEEK is created using the AYMD function, which takes a date, a number of
days to add to that date, and a date format. In this case, we are using &YYMD, which
is a system variable that provides the current date in YYMD (year-month-day) format.
We are subtracting one week (seven days) from the current date. The date format is
YYMD.

The date format needs to use the full month name, and must be in month-day-year
order. We will use the CHGDAT function to convert the date to the proper format for
both the &&FROM_DATE and the &&TO_DATE global variables. The CHGDAT function
uses four parameters: the format of the input date, the order of the output date, the
input date value, and the output date string format as an alphanumeric field.

The format of our two input dates, the date of one week ago set by the AYMD function
and the current date, are both in YYMD format, so that is the first argument of both
CHGDAT functions. Similarly, the output of both functions is MDYYX, which generates
a date with the full month name in month-day-year order. Typically, the format for such
a date would be MtrDYY, but since the CHGDAT function uses date character strings
instead of actual date values, it has its own date format designations. MDYY sets the
date order as month-day-year, with the year written in four digits, and the X indicates
that the full month name should be displayed.

The third argument of the CHGDAT function is the date to be converted. For the
&&FROM_DATE variable, it is &LASTWEEK, which was previously defined in this
FOCEXEC using the AYMD function. For the &&TO_DATE variable, it is &YYMD, a
system variable representing the current date in YYMD format.

Finally, A17 defines the string length of the converted date. 17 characters is long
enough to fit any date string.
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For more information about the AYMD and CHGDAT functions, see the Using Functions
technical content.

d. Save your changes and close the Text Editor.

The FOCEXEC must be available to any users for whom you want to set default values
in the page. Save it in a location where it will be accessible and then publish the
FOCEXEC, or share it with any users after saving.

2. Bring the global variable into effect by either running the FOCEXEC or mapping its path in
the Administration Console for it to be run when the user signs in.

To map the FOCEXEC you just created in the Administration console, add the focexec path
to the Paths to be executed on user Sign-in field in the Other section under Application
Settings. The FOCEXEC path name can be copied from the Properties panel on the Home
page.

3. Assemble a page from existing content, as described in the Visualizing Data Using Db2
Web Query Designer technical content.

4. Populate your new page with the content that is filtered for a date range, and add the
calendar control to the page using the Filters tab on the sidebar, as described in Applying
Prompted Filters From External Content on page 41.

5. Select the calendar control, open the Properties panel and, in the Settings tab, under Data
Settings, type the default value variables that you created in the FOCEXEC (in this case,
&&FROM_DATE for the first value and &&TO_DATE for the second value).

1. Creating Reports

Using Db2 Web Query  83



The following image shows an example of the Default value property populated with the
variable.

6. Save and run your page.
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The default date range in the calendar control is automatically set to the past week. The
dates will update every day to always represent a period of one week.

Changing a Field Format

Changing the display or output format of fields that have been placed on the canvas or in field
containers allows you to control how values in a field are interpreted and the styling that they
use when displayed. This feature allows for field display formatting, which is essential for any
data-based content design tool.

In a report, the field format is reflected in the format of data values. In a chart, the field format
may be reflected in data values in the chart, if they are displayed, or in the tooltip. Note that
series based data labels in a chart are formatted independently from the field itself.

Note: These formatting options are applied when the Db2 Web Query Server retrieves data
from the data source. When that data is passed to the JavaScript chart engine to generate a
chart, some formatting information may not be included and replaced with default settings. For
reports, the selected field formatting options are passed directly.
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When you change the field format, a new calculated field is created with the new format,
replacing the original field. The calculated field is also added to the field list. The new field is
identified by the number 1 appended to the field name and title. Additional format changes can
be applied directly to the new, reformatted field, without creating additional calculated fields.
The original field is still available in the field list if you want to restore the original format
without using the field format options.

To change the format of a field in a bucket on the Properties panel, right-click the field and
point to Format data, as shown in the following image.

Note: When editing the format of a field, the only options available are those that are relevant
to the selected field.
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When creating or editing a calculated field, you can access Data Format options by clicking the
Edit Format button, which appears with a different icon depending on whether the field is a

number , character , or date field , and which is located above the Operator Selection
pane next to the field name, as shown in the following image.
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To edit the format of a field, first select the data type, then set details specific to that data
type. In the following image, the numeric data type is selected, providing options for numeric
fields.

You can select one of the following data types:

Character format, for fields containing letters and numbers.

Number format, for fields containing numbers that you want to sum or aggregate.

Date format, for fields containing dates.

Other format, for fields that have values that do not match one of the other formats, such
as date-time fields or string fields, or are a variety of another type of field, such as packed
decimal fields or Julian date fields.
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When you select the character data type, you can specify character-specific formatting, as
shown in the following image.

You can use the Length option to select the number of characters to display in the field, and
enable variable length. Variable length indicates that the number of characters can vary
depending on the data that is stored in the field.

When you select the numeric data type, you can specify number-specific formatting, as shown
in the following image.
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You can choose whether or not to display decimals, and set the maximum number of digits to
show before and after the decimal point. You can also choose how to format negative
numbers, whether to show thousands separators, and whether to show a zero before the
decimal point when the value is less than one.

You can also specify currency and percent variations, such as a different currency symbol or a
change in the use of a percentage value. When you select the currency option under Type, the
Currency symbol and Symbol position options appear, allowing you to select the currency
symbol and how it displays. When changing the format of a numeric field, a preview shows an
example of what data values may look like based on the current field format settings.

Note: The Percent data format option automatically multiplies the field value by 100 so that
decimal values are accurately converted to percentages. If your data values do not need to be
multiplied by 100 and only need the percent symbol (%) added, select the custom format data
type and manually enter a field format followed by %. For example, D12.2%.

When your data type is a date field, you can make a selection from the supported date formats
that are available for selection. The options for a date field are shown in the following image.

The Date format menu shows a list of date formats as applied to December 31 of the current
year. You can select date formats that use separators or month names, or show a single date
component.

When you select a date format that uses a separator, the Date separator menu is available.
You can choose to use a slash (/), dash (-), dot (.), or space.
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If you want to use a format not available in the character, number, or date sections, you can
select the Other data type. Type a valid Db2 Web Query field format into the Format text box.
For example, the following image shows a field using the format HMDYYS, which is a date-time
format.

The Other data type, like all of the other data types, does not allow field transformations,
which prevents invalid formats. If the field was originally alphanumeric, you can enter a custom
alphanumeric format. If the field was originally numeric, you can enter a custom numeric
format. If the field was a originally a date field, you can enter a custom date format.

Procedure: How to Change the Number of Decimal Places in a Field

You can change the number of decimal places that display for a numeric field to show fewer or
more decimal values. Showing more decimal values allows you to analyze your data with
greater precision, while showing fewer decimal values may help make information more
immediately digestible.

1. Open Db2 Web Query Designer. On the default Db2 Web Query Home Page, click Visualize
Data.

Db2 Web Query Designer opens in a new browser tab.

2. Select a workspace with access to the wf_retail sample data, and select wf_retail_lite.mas
as the data source.

Db2 Web Query Designer loads with options to create a single content item.

3. Change the content type to a report. In the Content picker, select one of the report
layouts.

Using a report makes it easy to see all data values directly on the canvas. If you are
creating a chart, you can see exact data values when you point to a section of the chart to
display a tooltip.
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4. Add a sort field, for example, Product Category, to the Row bucket and a measure field, for
example, Revenue Per Sq. Ft., to the Measure bucket.

5. Change the format of the measure field to show four digits after the decimal point, by
doing the following:

a. In the Measure bucket, right-click a field and point to Format data, as shown in the
following image.
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b. If the field is not already in a numeric format, change the data type to numeric by
clicking the number button in the Data type section, as shown in the following image.

c. To display decimals, ensure that the integer option is not selected in the Type section.
You can select the decimal, currency, or percent option depending on how you want
the field to display.

d. To change the number of digits after the decimal, use the arrow control to increase or
decrease the Decimal place value, or type a number in the text box.

e. Check the data preview in the Sample data text box. If it shows the symbols and the
number of values that you want to display in your content, click OK to accept your
format changes.

The field whose format you modified is replaced with a new version that shows the specified
number of decimal points, as shown in the following image.
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The field whose format you modified now shows the specified number of decimal points, as
shown in the following image.

Creating Calculations

When you create content, you are not restricted to the fields that exist directly in your data
source. You can add calculations to automate summations and other mathematical tasks
related to your data fields. You can specify operators, fields, variables, and functions when
creating a calculation. If you can generate the information you want from the existing data, you
can create a temporary field to evaluate and display it. A temporary field is a field whose value
is not stored in the data source, but can be calculated from the data that is there. A temporary
field takes up no storage space in the data source, and is created only when needed.
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You can create two types of temporary fields, which differ in how they are evaluated:

A pre-aggregation calculated field, or DEFINE, is evaluated as each record that meets the
selection criteria is retrieved from the data source. The result of the expression is treated
as though it were a real field stored in the data source.

A post-aggregation calculated field, or COMPUTE, is evaluated after all the data that meets
the selection criteria is retrieved, sorted, and summed. Therefore, the calculation is
performed using the aggregated values of the fields.

Performing Basic Calculations

You can use the calculator to perform basic calculations on fields in your data hierarchy. When
you create a calculated field, a new, unique field is created. It incorporates all of the data
fields and expressions that you added to the calculation.

Once the calculation is complete, a new data field is created which can subsequently be used
in your content. This field is placed on the Data pane, using the label of the originating field on
which you created the initial calculation. For example, you can perform an addition operation
on two fields. This action sums the values of the fields, displaying the total of the two when
the field is used in a chart. You can also perform more advanced calculations that can result in
different outcomes.

Calculated fields include DEFINEs, COMPUTEs, quick transforms, and more. You also have
access to Db2 Web Query functions that can be used in a calculation to perform specific

operations on character and numeric fields. These display in a list of available functions .
They are separated into categories, listed in alphabetical order, and are case-insensitive.

A DEFINE field is evaluated before data aggregation, while a COMPUTE field is evaluated after
data aggregation. This means that DEFINE fields are especially useful to sort the data in a
chart or report, while a COMPUTE field is especially useful as a measure field.

You can determine whether a calculation will be created as a DEFINE or COMPUTE by selecting
Calculate at the source or Calculate after aggregation in the calculator. When you select
Calculate at the source, a DEFINE field is created, and when you select Calculate after
aggregation, a COMPUTE field is created. When you create a DEFINE field, it is added to the
field list, from where you can add it to your content. When you create a COMPUTE field, it is
added to your content automatically, in the default measure bucket if it was created from the
field list, or in the bucket from where you created the COMPUTE.
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Access the calculation feature in one of the following ways:

Right-click a field in the Resources panel and click Add calculation. This creates a DEFINE,
by default, with the selected field added automatically to the calculation. If you create a
DEFINE, it is added to the Resources panel, from where you can add it to your content. If
you create a COMPUTE, it is added to the default measure bucket.

Right-click a measure field in a bucket and click Add calculation. This creates a COMPUTE,
with the selected field automatically added to the calculation. The calculated field is added
to the bucket from where you accessed the calculator.

Click the menu in the Dimensions area or Measures area of the Resources panel, and click
Add calculation. This creates a DEFINE, by default. If you create a DEFINE, it is added to the
Resources panel, from where you can add it to your content. If you create a COMPUTE, it is
added to the default measure bucket.

When creating a report, click the menu for the Rows bucket or the Summary, Count, Detail,
or Detail with counter bucket, and click Add calculation. This creates a COMPUTE. The
calculated field is added to the bucket from where you accessed the calculator.

Right-click a calculated field that you created previously and click Edit calculation. This
allows you to modify an existing calculated field. This option is available from the field list
for DEFINE fields, and from a bucket in the Properties panel to which a calculated field has
been added.
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When you perform one of these actions, the calculator opens, as shown in the following image.

The numbering in this image points out the different areas of the interface, as a guide.

1. Title bar. Shows context information about the current calculation. For example, New
Calculation or Edit Calculation, along with the field name.

2. Evaluation options. Determines the type of calculation. Select Calculate at the source to
create a pre-aggregation, DEFINE field, or select Calculate after aggregation to create a
post-aggregation, COMPUTE field.

3. Close button. Closes the Calculator. Clicking this button performs the same function as the
Cancel button.

4. List chooser. Allows you to select which list should be displayed in the Calculator. For
example, functions.

5. Search box. Allows you to search for components across all subjects (Fields, Functions,
and Variables). The search will find matches on contiguous text and performs a case-
insensitive search. A flat list of matches is returned.

For Fields, matches are performed on Name, Title, and Positional (folder or segment)
information in the hierarchy.

For Functions, matches are performed on Name, Category, Parameters, and Help text.
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For Variables, matches are performed on Name.

6. Field/Function/Variable list. Lists the fields, functions, or variables that are available for
selection and on which you can perform a calculation.

The following considerations apply to Field/Function/Variable lists.

A Field list will always present with Single-list mode. It operates the same way as the
Field List tab in the Field Tree.

The Function list displays a categorized list of Db2 Web Query functions, sorted case-
insensitive in alpha order (ascending or descending). You can use the drop-down menu
to select the category of the function that you want to use, or you can search for a
function. Double-click or drag and drop a function into the Canvas and then supply
parameter values to use it.

You can still use a function, even if it is not listed, by typing it into the calculator
canvas. See the Using Functions technical content for a complete list of available
functions, including legacy functions.

A Variable list displays a list of system variables in Db2 Web Query. The Variable list tab
operates the same way as the Variable list tab in the Field Tree.

7. Calculated field definition area. Displays the field name for which an expression is being
created. It displays an icon (separate) to allow its format to be set with the Data Format
Selector.

Format icon. You can use the Format icon to change the target field format for the
calculation.

Properties icon. Enables you to change the target field properties for the calculation,
such as the field name and title, and whether to allow missing values.

8. Operator Selection pane. This pane displays a full, contextualized list of operators that are
available in calculations. It also displays mathematical and logical operators. Additional
statements (IF, THEN, ELSE) are also included.

9. Canvas/typing surface. This is where you build your calculation. It shows fields,
aggregations, and other items related to the calculation you are creating. It also supports
functions, variables, operators, values, and placeholders.

10.Function Help. When working with Functions, you may receive help messages, such as a
description of the selected function and the values that you must supply.

11.Actions. Includes a Validate button that allows you to check whether the syntax that you
have provided for the DEFINE or COMPUTE is structured correctly, and options to cancel or
commit the calculated field.
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Procedure: How to Create a DEFINE Field Using a Db2 Web Query Function

A DEFINE is a virtual field that is evaluated as each record that meets the selection criteria is
retrieved from the data source. The result of the expression is treated as though it were a real
field stored in the data source. It is added to the field list in the Resources panel, from which
you can add it to multiple content items.

You can use a Db2 Web Query function in a DEFINE or in a COMPUTE to transform data from
an existing field to create a new field. Each function accepts a different set of arguments that
are added in parentheses after the function name.

DEFINEs are built from the field list in the Resources panel.

DEFINEs can be created in the following ways:

In a Master File. These virtual fields are available whenever the data source is used.

In a procedure. A virtual field that is created in a procedure lasts only for that procedure.

In this example, a new DEFINE field will be created that uses the DTRUNC function to supply
the first day of the week for each sale date.

1. Create a new visualization in Db2 Web Query Designer, using wf_retail_lite.mas as the
data source.

2. With the Fields tab selected from the sidebar, in the Resources panel, right-click a field or
click the menu next to the Dimensions area or Measures area, and then click Add
calculation.

The calculator opens to create a new DEFINE field, by default. Notice that the Create at the
source radio button is selected.

3. In the Calculator dialog box, click the Functions tab .

The Function list appears, and displays the first available function category.

Note: If you create the new calculation by right-clicking a field, that field is automatically
added to the calculator text area. For the present example, delete this text before
continuing.

4. Navigate to the DTRUNC function using one of the following methods:

In the search box, type DTRUNC.

Expand the function category drop-down menu, and select Date/Date-Time.

Double-click the DTRUNC function, or drag it into the Calculator text area.
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The text area displays the function and identifies the required arguments, in this case,
date and period. Notice that an example is provided in the space below the calculator text
area.

5. In the text area, inside the parentheses after DTRUNC, select the word date.

6. In this space, specify the input date that will be used to provide the first day of the week.
In this case, instead of a single date, provide an entire date field, so that the DEFINE field
will generate a value for each input date value.

Click the Fields tab  to access the Field list. Under Dimensions, expand Sales_Related,
Transaction Date, Simple, Sale,Day, and Sale Date Details, then double-click Sale,Date.

The Sale Date field is added as the first argument in the DTRUNC function, as shown in
the following image.

7. Replace the word period with the date component that you want the field to use as
increments. In this case, it is the first day of each week. Type WEEK as the second
argument in the DTRUNC function, in place of the period placeholder text. The completed
function should resemble the following:

DTRUNC("Sale,Date", WEEK)

8. Since the output of the DTRUNC function is a date field, the DEFINE field should use a
date format.

Click the Edit format button, change the Date type to a date format, and select an option
of your choice from the Date format drop-down menu.

Click OK.

9. Optionally, double-click the name of the DEFINE field to change it.

10. Click Validate to confirm that the DEFINE is set up correctly.

11. Click OK to return to the calculator.

If the validation indicated that there was an error, determine the cause of the issue and fix
it.

12. Click OK to finish creating the DEFINE field.

If you created the DEFINE by right-clicking a field in the Field panel, it displays at the
bottom of the measure or dimension group where it was created from. If you have trouble
locating your calculated field, type the name into the search box to find it.

13. Add the DEFINE to your content as a sort field.
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You can use the calculated field from this example to create a chart or report that shows
sales information for each week, as shown in the following image.

Procedure: How to Create a COMPUTE Field

COMPUTEs are calculated fields whose values are evaluated after all of the data that meets
the selection criteria is retrieved, sorted, and summed. The calculation uses the aggregated
(total) values of the fields. For example, based on the values of Revenue and MSRP fields in
your data source, you could calculate the discount percentage.

Create a COMPUTE field by selecting Calculate after aggregation in the calculator.

1. Create a new visualization in Db2 Web Query Designer, using wf_retail_lite.mas as the
data source.

2. With the Fields tab selected on the sidebar, on the Resources panel, in the Measures
area, expand the Sales folder, and double-click the Revenue field to add it to a measure
bucket.

3. From the measure bucket, right-click the Revenue field and click Add calculation.

4. In the Calculator dialog box, build the COMPUTE.
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Note: The field that you right-click to create the COMPUTE field is automatically added to
the text area, as shown in the following image.

You can select another field, or add fields from the data source tree that display.

Note: For COMPUTEs, the Calculate after aggregation check box is selected, indicating
that the field values are evaluated after the chart or report has been sorted.

5. Type the mathematical expression to create a COMPUTE field to evaluate the discount
percentage using the Revenue and MSRP fields:

a. Click to place your cursor before the Revenue field in the text area, and type 1 - (.

b. Click to place your cursor after the Revenue field, and type /.

c. From the data tree, under Measure Groups, expand the Sales folder and double-click
the MSRP field to add it to the expression.

d. Type ) to close the expression. The completed expression for the COMPUTE field
should resemble the following:

1 - ("Revenue"/"MSRP")
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The following image shows this expression in the Calculator.

Note: You can use the buttons in the Operator Selection area instead of typing some
mathematical operators.

6. To show the discount percentage as percentage values instead of as a decimal, change
the format of the calculation.
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Click the Format icon to open the Format dialog box. Click the Percent Type option to
change the field format to a percentage, as shown in the following image.

The percentage option automatically multiplies the values in the field by 100 to produce a
percentage, so we do not need to perform this operation in the COMPUTE expression.

7. Click OK to accept the field format change.

8. Optionally, change the name of the COMPUTE field. It is assigned a default name based
on where the COMPUTE field was created from. Unless you specify a different column title,
this name appears in the bucket where the COMPUTE is used and in your content.

Double-click the field name next to the Format icon, and type a new name for the field.

9. Optionally, change the column title that displays for the COMPUTE field when it appears in
your content.
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Click the Field Properties menu, and type a column title for the field, as shown in the
following image.

10. Click OK to accept the new column title for the COMPUTE.

11. Click Validate to confirm that the COMPUTE is set up correctly.

12. Click OK to return to the calculator.

If the validation indicated that there was an error, determine the cause of the issue and fix
it.

13. Click OK to finish creating the new COMPUTE field.

The field is added to the same bucket from which you created it. You can move it to a
different bucket or delete the original field, Revenue, in this example, from which it was
created.
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The following image shows a data grid that displays the Revenue and the calculated
Discount Percentage for different product models.

If you remove the COMPUTE field from your content, it is deleted permanently. COMPUTE fields
are not stored in the Resources panel.

Procedure: How to Edit an Existing Calculation

Once you have created a calculated field (DEFINE or COMPUTE), you can edit it. This allows you
to revise the calculation and in the field so that you can achieve the results you expect.
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Note: You cannot edit a calculated field that is already being used in a static or prompted
filter. You may, however, delete the filter, edit the calculated field, then recreate the filter using
the edited field.

1. On the Db2 Web Query Home Page, locate a visualization with new content that uses a
calculated field. Right-click it and click Edit.

Db2 Web Query Designer opens.

2. If you created a DEFINE field, the calculated field was added to the Field panel. Right-click
the calculated field and click Edit calculation. If you created a COMPUTE field, or already
added the DEFINE field to your content, you can also edit it from the bucket to which it
was added.

3. Modify the calculated field using the calculator.

4. Click Validate to confirm that the calculated field is set up correctly.

5. If the validation indicated that there was an error, determine the cause of the issue and fix
it.

6. Click OK.

The revised field displays in the location from which you edited it.

Using Prefix Operator Aggregation Functions

You can use prefix operator aggregation functions to instantly apply a number of different
aggregation operations to fields, unlocking significant insight into your data without writing your
own calculations.

To apply a prefix operator, right-click a field in a measure bucket in a chart or report, point to
Aggregate, and select one of the following options:

None. Does not explicitly apply a prefix operator. When the Summary display option is
selected, the Sum aggregation is used. When the Count display option is selected, the
Count aggregation is used. When the Detail or Detail with counter display options are used,
no aggregation is applied.

Sum. Adds record values together for the selected field within each sort value.

Average. Calculates the average of record values for the selected field within each sort
value.

Count. Provides the number of record values for the selected field within each sort value. If
there are no missing values in the data source, the count aggregation returns the same
value for every field.
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Count distinct. Provides the number of distinct record values for the selected field within
each sort value.

Percent. Calculates a percentage for each sort value based on the summed total value for
the selected field.

Percent of count. Calculates a percentage for each sort value based on total record count
for the selected field.

Minimum. Provides the minimum value for the field within each sort value.

Maximum. Provides the maximum value for the field within each sort value.

Median. Provides the median field value with each sort value.

Mode. Provides the most common value of the field within each sort value.

Standard Deviation, Sample. Provides the standard deviation of the field, within each sort
value. Sample standard deviation uses Bessel's correction of n-1 to calculate the standard
deviation.

Standard Deviation, Population. Provides the standard deviation of the field, within each
sort value. Population standard deviation is calculated using n to represent the number of
records in the request.

Distinct. Available only when creating reports with the Detail and Detail with counter display
options. Displays only distinct values.

Total. Available only when creating reports with the Detail and Detail with counter display
options. Provides a grand total for the field. The Total operator (TOT.) can also be applied to
a measure field in a header or footer to show the total value.

The operation is instantly applied to the field, indicated by a prefix in the measure bucket.

When you add an alphanumeric field to a measure bucket, the only available aggregations are
Count, Count distinct, and Percent of count. These options allow you to understand the
distribution of values in alphanumeric dimension fields. When you add an alphanumeric
dimension field to a chart as a measure, the Count aggregation is applied automatically in
order to generate aggregated values for the chart.

When using Count display option, the Count prefix operator is used by default, but other
operators, including Sum, can also be applied. These operators behave the same as when
using the Summary display option. When using the Detail and Detail with counter display
options, measure values are not aggregated. As a result, Detail and Detail with counter fields
can only use the Distinct, Total, and Percent prefix operators.
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You can use the same field multiple times in a chart or report with different prefix operators to
enhance your understanding of your data set. For example, the report in the following image
shows columns for average revenue and median revenue, which helps to understand the
skewness of the data.

Since the average revenue values for each product category are all greater than the median
revenue values, we can see that the data is skewed to the right. This means there are a higher
proportion of records with lower than average revenue, and that the average revenue is brought
up by some outlying high revenue values.
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Similarly, you can use the Count prefix operator in combination with the binning feature to see
the distribution of your data, such as in a histogram. To create a histogram, create a new
chart, right-click a measure field in the Resources panel, point to Bin values, set a bin size and
labeling option, and click OK. The bins appear as a field in the Dimensions area of the
Resources panel. Drag the bin field into the sort bucket of your chart, such as the Horizontal
bucket in a bar chart. Next, drag the same field for which you created your bins from the
Measures area into the bucket used to aggregate measure data in the chart, such as the
Vertical bucket in a bar chart. Finally, right-click that measure field, point to Aggregate, and
click Count. The result is a histogram showing the distribution of values for the selected field,
as shown in the following image.

Using Quick Transforms to Apply Analytical Functions to Data Fields

With quick transforms, you can easily apply the most commonly used analytical functions to
measure fields in your content. This allows you to quickly apply a function to a field as you
create content, expanding your options for incorporating aggregated data.
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Quick transforms are robust and support a variety of functions. For example, you can perform a
rolling or moving aggregation or correlation (both COMPUTEs) on a measure field. This makes it
easy to perform the calculations you need to understand the distribution and patterns in your
data with just a few clicks. To access these options, right-click a measure field in your chart or
report, point to Quick transform, and then point to one of the quick transform options. Each
quick transform allows you to configure how the calculation is performed. The following options
are available:

Rolling aggregate. Reaggregates the total values in the request at each sort value.

Moving aggregate. Reaggregates subtotal values in the request, for a fixed number of
previous sort values, at each sort value.

Correlation. Calculates the correlation coefficient between two numeric fields.

Cluster. Partitions values into a specified number of clusters, based on the nearest mean
value.

You can do this from the shortcut menu for a measure field added to a non-sorting bucket in a
chart or report, such as the Vertical bucket in a bar chart. Placing a measure in the Horizontal
bucket, which is used to sort a bar chart, creates entries for each underlying value. In this
case, you do not have access to the Quick transform option.

Other examples include the use of the correlation function, which calculates the correlation
between two numeric fields. This is often used to display how strongly two variables are
related to each other. In addition, the cluster (KMEANS) function partitions observations into a
specified number of clusters based on the nearest mean value. The goal of cluster analysis is
to group, or cluster, observations into subsets based on their similarity of responses on
multiple variables.

Quick transforms create post-aggregation (COMPUTE) virtual fields. A calculated value
(COMPUTE) is evaluated after all of the data that meets the selection criteria is retrieved,
sorted, and summed. This means that the quick transform calculation is performed using the
aggregated values of the fields.
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Performing a basic aggregation with a quick transform allows you to convert a field value from
its raw state into a calculated field. With the Discount field, you can create a rolling sum that
shows the cumulative sum of the field as it changes for each value in the chart. The Quick
transform options are shown in the following image.

Note: You can perform multiple quick transforms using the same originating field.

Here, you can specify the type of aggregation (for example, Sum, Average, Count, and others)
and indicate whether you want to keep the original field. The Keep original field option is
selected, by default, if the bucket supports multiple measure fields, and serves the purpose of
preserving the original field for other use in your chart. You can also choose to replace the field
in favor of the transformed field, by deselecting this check box.

When you perform a quick transform on a field, a new, unique field is created and placed in the
same bucket as the originating field, as shown in the following image.
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The transformed field is now a COMPUTE, which is a post-aggregation calculated field. It is a
separate field, labeled with the transformation that was applied. You can move the
transformed field into a different measure bucket to make it easier to analyze your data. For
example, the following image shows a scatter chart with Model values plotted based on
Quantity Sold and MSRP values. The Cluster quick transform was performed on the MSRP field
using the Average aggregation, creating four groups of models with similar average MSRP
values. The cluster field has been moved into the Color bucket, making it easy to identify which
cluster each model falls into.

Procedure: How to Apply a Rolling Aggregation to a Report Using Quick Transforms

A rolling aggregate, or cumulative moving aggregate, is a cumulative aggregation of values. The
aggregation is recalculated for each data record, allowing you to see totaled or recomputed
values at various points in a chart or report.

You can add a rolling sum to a report that is sorted by year, quarter, and month values,
allowing you to see the total sales data for different points in time. You can also break the
rolling sum on a lower-level sort field, allowing you to view a separate rolling sum for different
categories.

1. Open Db2 Web Query Designer. On the default Db2 Web Query Home Page, click Visualize
Data.

Db2 Web Query Designer opens in a new browser tab.

2. Select a workspace with access to the wf_retail sample data, and select wf_retail_lite.mas
as the data source.
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Db2 Web Query Designer loads with options to create a single content item.

3. On the Content picker, select one of the report layouts as the content type.

4. With the Fields tab selected on the sidebar, on the Resources panel, in the Dimensions
section, expand Sales_Related and Transaction Date, Simple, and double-click Sale,Year,
Sale,Quarter, and Sale,Month, in order, to add them to the report in the Rows bucket.

5. On the Resources panel, in the Measures section, expand Sales and double-click Revenue
to add it to the Summary bucket.

The report now shows Revenue by Sale Year, Sale Quarter, and Sale Month.

6. To see how the total revenue increased over time, add a rolling sum quick transform on
the Revenue field.

a. In the Summary bucket, right-click the Revenue field, point to Quick transform, and
then to Rolling aggregate.

b. Leave the selected Aggregation option as Sum.

You can select a different aggregation option to recalculate that aggregation at each
row of the report.

c. Leave the Break on option set to None. The rolling sum will continue accruing
throughout the entire report, without resetting.

d. Leave the Keep original field check box selected, so that you will still be able to see
the Revenue values for each month.

e. Click OK.
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The quick transform field, called Revenue rolling sum, by default, is added to the
report. It displays the total revenue that has been accrued up to each month, as
shown in the following image

7. Add a new rolling sum quick transform field that breaks on the Sale Year field, thereby
showing the accrued revenue at different points within each year.

a. In the Summary bucket, right-click the Revenue field, point to Quick transform, and
then to Rolling aggregate.

b. Open the Break on drop-down menu and select Sale,Year.

c. Click OK.
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A new quick transform field, called Revenue rolling sum Sale Year, by default, is added
to the report. Notice that the values continue increasing until the end of each year, at
which point they reset and start accruing again, as shown in the following image

Using this report, you can see when certain revenue goals and thresholds were met.

Procedure: How to Apply a Moving Average to a Chart Using Quick Transforms

You can use a rolling or moving average to smooth out the data in your chart or report, making
it easier to identify trends and patterns.
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While, a rolling aggregate is a cumulative aggregation of all of the values in a chart or report, a
moving aggregate is a cumulative aggregation that is performed on a limited selection of the
most recent values. As the moving aggregate proceeds through the sequence of values in your
chart or report, earlier values are gradually discarded from the calculation as they fall outside
the scope of the moving aggregation. A moving average, therefore, is an average that is
recalculated at each value for that value and a specified number of prior values.

To create a moving average based on a measure field in your content:

1. Open Db2 Web Query Designer. On the default Db2 Web Query Home Page, click Visualize
Data.

Db2 Web Query Designer opens in a new browser tab.

2. Select a workspace with access to the wf_retail sample data, and select wf_retail_lite.mas
as the data source.

Db2 Web Query Designer loads with options to create a single content item.

3. Use the Content picker to change the chart type to a vertical side-by-side bar chart.
The moving average will be added to the chart as a second measure, and since we want to
compare it directly to the non-transformed field, the bars should be aligned side-by-side
instead of stacked.

4. On the Resources panel, in the Dimensions section, expand Sales_Related and
Transaction Date, Components, and double-click Sale,Year/Quarter to add the Sale Year/
Quarter field to the chart in the Horizontal bucket.

5. On the Resources panel, in the Measures section, expand Sales and then double-click
Revenue to add the Revenue field to the Vertical bucket.
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The result is a bar chart showing revenue for each quarter of each year, as shown in the
following image.
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6. Right-click the measure field in the Vertical bucket, in this case, Revenue, and point to
Quick transform, as shown in the following image.

7. To add a moving average to the chart, point to Moving aggregate and:

a. From the Aggregation menu, select Average, which is the default. You can alternatively
create a moving sum, moving count, and more.

b. Since there is only one sort field in the chart, the Break on option is not available.

If we had added a second field to the Horizontal bucket, you would be able to select a
field on which to break the moving average.
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The default selection is None. When None is selected, the moving aggregation
continues for every value, and never resets. If you have multiple sort fields in the
chart, and you select a field to break on, the aggregation starts over for each new
value of that field. You cannot break on the lowest sort field or the only sort field,
since this would cause the rolling aggregation to reset on each value.

c. Set the Look back value to 8. The Look back value determines the number of past
values to include when evaluating the moving aggregation. In this case, we will use
the last two years of data to calculate the moving average.

Use a higher Look back value to make a smoother moving average. Using a lower
value results in a less smooth moving average, but makes the moving average more
responsive to changes to the data.

d. Leave the Keep original field check box selected. This check box controls if the
original field on which you are basing the quick transform is retained in the bucket.
This check box is selected, by default.

If you leave it checked, both the original field and the new calculated field will share
the bucket from which the quick transform was created, if possible. If you do not want
to keep the original field, you can replace the field with the quick transform field by
deselecting the box. Single-field buckets, such as Size or Color, always replace the
original field, and do not provide this option.

8. Click OK.

The field is placed in the measure bucket and displays in your content, by default. The
legend is also updated to reflect this new field, as shown in the following image.
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Notice that since we used a fairly high Look back value of 8, the moving average bars have
a smooth growth that allows us easily identify a general pattern in the data, but do not
increase quite as quickly as the actual revenue values.

9. Optionally, you can change the moving average fields to display as a line instead of bars,
more clearly differentiating the moving average from the actual revenue values.

In the Vertical bucket, right-click the moving average field, point to Shape, and click Line.

The moving average now displays as a line, as shown in the following image.
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Using Dynamic Grouping for Dimension Field Values

Dynamic grouping allows you to create groups of elements based on the field data type that
you select. For example, you may have a field with US state names, but no field for US regions.
Using the dynamic grouping functionality, you can create groups for different regions for use in
a content item without editing the data source. You create one group that combines state
name values like Maine, New Hampshire, and Massachusetts into a New England group,
states such as New York, New Jersey, and Pennsylvania into a Mid-Atlantic group, and so on.
You can even add the extraneous, remaining values into an Other group automatically, if you
do not think they fit into another defined group.

Note: The Create Group option is only available for dimension fields of non-numeric format or
attribute.

You can also specify multiple, unique groupings in the same session. For example, you might
want to group the data to indicate groups or products, or specific regions.

Note: If you want to exclude a specific data element from your analysis, you can use the filter
functionality.

The grouping that you specify is applied and this new group then replaces the original field that
you selected in the Query pane. The name that you specify when creating the group is reflected
in the Query pane.

The process of dynamic grouping creates a Define field, which can then be used in other
reports or charts in the same visualization. When creating a single content item, dynamic
grouping also supports Auto Drill, enabling you to drill through the hierarchy of your data just
like any other data field.

Procedure: How to Create a Dynamic Group

1. Open Db2 Web Query Designer. On the default Db2 Web Query Home Page, click Visualize
Data.

Db2 Web Query Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

Once you select a data source, Db2 Web Query Designer loads with options to create a
single content item.

3. On the Resources pane, with Fields selected on the sidebar, right-click the data field for
which you want to apply dynamic grouping.

Note: You can use the dynamic grouping functionality on non-numeric dimension fields
only.
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4. Click Group values.

The Create Groups dialog box displays.

5. In the Field text box, optionally type a name for the new group field.

Note: The fully qualified field name is displayed as the Origin Field at the bottom of the
Create Groups dialog box. The display of the fully qualified field name is particularly useful
when renaming or editing a group, as it identifies the data source followed by the
hierarchical location of the field within a data set. For example,
WF_RETAIL_LITE.WF_RETAIL_PRODUCT.BRAND.

6. Create a group of values in one of the following ways:

Use Ctrl + click to select more than one value, as shown in the following image, then
click Group.

Drag one value onto another value. The two values are grouped.

7. Optionally, double-click the group title or select a group and click Rename, and then type a
new name for the group.
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8. Optionally, add more values to the group that you just created using one of the following
methods:

Select one or more values, open the Add to menu, and select a group to add the
values to.

Select one or more values and drag them into a group.

Drag the group onto a single, ungrouped value. The value is added to the group.

If you have multiple groups, drag one group into another group to merge them. The
name of the target group is retained for the merged group.

These methods can also be used to move a value from one group to another group.

9. Optionally, create additional groups using the methods in step 7, as shown in the following
image.

10. Optionally, to ungroup values, click a group and then click Ungroup. Click Ungroup all to
disband all groups.

11. Optionally, click Show other to add all remaining non-grouped values to an Other group.

Note: If you add all values to the Other group, all groups, including the Other group, are
disbanded. You must have at least one group for the Other group to be available.
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12. Click OK.

Your grouped data will display as a new field in the Resources panel. If it is not
immediately visible, you can use the search feature on the field list to find it. From there,
you can add the grouped field to your content, as shown in the following image.

To edit the grouped field, right-click it in the Resource panel and click Edit group values.

Creating Numeric Ranges With Binning

In Db2 Web Query Designer, bins are used to group numeric values by the increment you
specify. This allows you to view large amounts of data across measures or calculated
measures, enabling you to analyze trends and identify outliers. Data binning also allows you
view your data as part of a larger group, displaying ranges of that data in manageable, visible
bins.
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For example, you might want to analyze Cost of Goods Sold against Discount to understand
how discounts impact the cost of goods. First, you add the Discount measure to the Vertical
field container. These values will be used as a guide for the comparative, grouped content in
the bin. If you apply a bin width value of 250 to the Cost of Goods measure, your data values
will be grouped into ranges of 250 (for example, 0 - 250, 250 - 500, 500 - 750). Finally, you
add the new binned dimension field (generated by the bin process) to your chart. Your chart
now displays the binned values against the Discount measure, as shown in the following
image.

As you can see in this example, there is a direct correlation between Cost of Goods and
Discount, with the smaller cost records values (0 - 250) constituting more of the discount
amount. From this example, it is evident that a large portion of total discounts are given for
lower cost items. In this case, binning has given you insight into the frequency distribution of
values in your data.
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Bins are created on a numeric measure field (for example, Gross Profit), as shown in the
following image.

Examples of numeric measure fields include Gross Profit or Discount. Once you create a bin, a
new dimension field is automatically created, allowing you to plot values based on your bin
specifications.

You can create or edit bins using the same options. On the Resources panel, right-click a field
and click Bin values, or right-click a binned field and click Edit bin values. This opens a shortcut
menu with the following options:

Bin width. A standard text box that accepts any number greater than 0.

Show as. Identifies the bin label type.

Value. Displays the alphanumeric representation of the numeric value containing the
minimum value (FLOOR) of each bin. The format should be set to the data format of the
source field.

Range. Displays the alphanumeric string representing the minimum and maximum range
for each bin. The format should be set to the data format of the source field.

OK. Creates a new dimension field based on the bin options that you selected. This
dimension field is automatically added under your dimensions in the Fields tab.

Cancel. Closes the shortcut menu and cancels the changes.
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The following image displays bin values and bin ranges for the DEALER_COST field, using a bin
width of 1000. It also shows how the data falls into the value and range properties.

Note: Bin fields that display ranges, using the Show as Range option, use a character field
format, while bin fields that display floor values, using the Show as Value option, use a
numeric field format. As a result, when displaying ranges, bins with negative numbers display
after bins with positive values. This is due to the sort sequence used for character fields. On
the other hand, when displaying floor values, bins are sorted into numeric order, so negative
value bins display before bins with positive values.
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Therefore, if the measure field that you are binning includes negative values, it is
recommended to select Value as the Show as option. Alternatively, you can display ranges in
numeric order by using a bin with values as a hidden, higher-level sort field and adding the bin
with ranges below it on the same axis. For example, if creating a vertical bar chart, create a
value bin field and a range bin field, both with the same width. Add the value bin field and then
the range bin field to the Horizontal bucket, then hide the value bin field. The ranges are now
in the correct order, as shown in the following image.

Editing an Existing Bin

Once you have created a bin, you can edit it. This gives you the flexibility of changing the size
of the bin or other related parameters. Changes to the bin values appear in real time.

You can edit an existing bin from the Data panel or if you have placed the bin in a bucket, by
right-clicking the bin and selecting Edit bin values.

Note: If a bin field is being used in a calculated field or in a filter, you cannot change the bin
label type.
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Procedure: How to Create a Histogram Using Bins

A histogram is a chart, usually in a bar chart format, that displays the frequency distribution of
values in your data by displaying the count of values in different ranges. The count aggregation
and bins should be applied to the same field to show the frequency distribution effectively.

1. Open Db2 Web Query Designer. On the default Db2 Web Query Home Page, click Visualize
Data.

Db2 Web Query Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

Once you select a data source, Db2 Web Query Designer loads with options to create a
single content item.

3. If the default content type is not a bar chart, select a vertical bar chart option from the
Content picker.

4. With the Fields tab selected on the sidebar, on the Resources panel, under Measures,
select a numeric measure field and place it in the Vertical bucket. You can also double-
click the field, or right-click it and select Add to chart.

5. Right-click the measure field in the Vertical bucket, point to Aggregate, and click Count.

The prefix CNT. is added to the front of the field name. The vertical axis now represents
the frequency of values of the selected measure field, rather than summed values.

6. On the Resources panel, under Measures, right-click the same measure field and point to
Bin values.

7. Specify a numeric value in the Bin width field. For example, using the numeric value 500
creates bins that group values of 500 together.

Keep in mind the overall range of values in the field that you are binning. Fields with
smaller variance work best with smaller bins, while fields with large variance work best
with larger bins.

8. Optionally, select a Show as option. Range, which is the default, shows the minimum and
maximum value for each range, while Value shows only the minimum value.

9. Click OK to generate the bins for the selected measure field.

Note: The binned measure is added to the Resources panel as a new dimension field that
you can use in your chart.

10. From the list of dimension fields, locate the field that is suffixed by _BIN_1 (for example,
REVENUE_US_BIN_1).

Creating Numeric Ranges With Binning

130  Information Builders



Note: The binned field is placed under Dimensions on the Resources panel. If you are
viewing these fields using the Folder view, it will be available under a folder with the same
name used under Measures. You can also use the search feature to locate the new
dimension field if needed.

11. Add this new dimension field to the Horizontal field container.

The bins display in your chart. Each bar represents a range of values, and the height of
each bar represents the number of records that fall into each range, as shown in the
following image.

From the image above, we can see that sales falling into the first two bins, up to $500 in
revenue, were the most frequent.

12. Optionally, to edit the bin width to produce more or fewer bins, or to toggle the bin label
type between ranges and values, right-click the bin field in the Horizontal bucket and point
to Edit bin values. You can then change the bin settings and click OK to apply them.
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